
novdocx (en)  11 D
ecem

ber 2007
GroupWise 7 
Support Pack 3

March 14, 2008

1  Overview
The information in this Readme file pertains to Novell® GroupWise® 7 Support Pack 3. This 
Support Pack contains updates for all components contained in the GroupWise 7 product. However, 
this Support Pack does not contain updates for GroupWise Messenger. GroupWise Messenger 2.0 
Support Pack 3 is a separate download.

GroupWise 7 Support Pack 3 includes the NetWare®, Linux*, and Windows* GroupWise 7 
software. The NetWare and Windows software is provided in one set of downloads; the Linux 
software, including the Cross-Platform client for Linux and Macintosh*, is provided in a separate set 
of downloads. 

2  GroupWise System Requirements
The system requirements for GroupWise 7 Support Pack 3 are the same as those currently 
documented for GroupWise 7. Complete GroupWise system requirements are listed in the 
GroupWise 7 Installation Guide (http://www.novell.com/documentation/gw7/gw7_install/data/
bp8vh01.html#bp8vh01).

IMPORTANT: GroupWise system requirements do not apply to GroupWise Mobile Server. For 
GroupWise Mobile Server requirements, see the GroupWise Mobile Server Readme (http://
www.novell.com/documentation/gw7/gmsreadmeus/data/gmsreadmeus.html).

3  NetWare/Windows: Support Pack Installation
Section 3.1, “NetWare/Windows: Administration Software Installation Instructions,” on page 1
Section 3.2, “Windows: Client Software Installation Instructions,” on page 2

3.1  NetWare/Windows: Administration Software Installation 
Instructions

IMPORTANT: If you are installing the GroupWise software in a cluster, refer to the GroupWise 7 
Interoperability Guide (http://www.novell.com/documentation/gw7) for cluster-specific installation 
instructions before starting to install the Support Pack.

1 Download the NetWare/Windows GroupWise 7 SP3 compressed executable file to a temporary 
directory on your NetWare or Windows server:

gw703_full_nwwin_us.exe for English only 
gw703_full_nwwin_multi.exe for multilingual
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2 Extract the .exe file into a directory at the root of your local drive or to a network server drive 
that can handle long pathnames.
The compressed file contains directory paths that could exceed DOS limits.

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the SP3 
administration files.

4 Select the setup.exe file, then click OK to run the GroupWise Installation program.
5 Click Create or Update a GroupWise System.

During installation of a Support Pack, the GroupWise Installation program requests access to 
existing GroupWise software. You can provide the path to a software distribution directory or 
you can use your original GroupWise 7 media.

6 Follow the on-screen instructions to create the GroupWise 7 SP3 software distribution 
directory and install the administration and agent software.
Update the primary domain first. Start the MTA in the primary domain. Then update secondary 
domains, followed by the post offices in each domain. Start each MTA and POA for each 
domain and post office. Then update the other GroupWise agents.
For additional instructions, refer to the GroupWise 7 Installation Guide on the GroupWise 7 
Documentation Web site (http://www.novell.com/documentation/gw7).

3.2  Windows: Client Software Installation Instructions
1 Download the GroupWise 7 SP3 Windows Client compressed executable file to a temporary 

directory on your workstation:

gw703_client_win_us.exe for English only
gw703_client_win_multi.exe for multilingual

2 Extract the .exe file into a directory at the root of your local drive.
The compressed file contains directory paths that could exceed DOS limits.

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the SP3 
client files.

4 Select the setup.exe file, then click OK to run the GroupWise client Setup program.
5 Follow the on-screen instructions to install the SP3 client software on your workstation.

4  Linux: Support Pack Installation
Section 4.1, “Linux: Operating System Update,” on page 2
Section 4.2, “Linux: Administration Software Installation Instructions,” on page 8
Section 4.3, “Linux: Cross-Platform Client Software Installation Instructions,” on page 9
Section 4.4, “Macintosh: Cross-Platform Client Software Installation Instructions,” on page 9

4.1  Linux: Operating System Update
If you are updating your version of Linux as well as updating GroupWise, perform the Linux 
operating system upgrade first. In addition, when you upgrade on a server where GroupWise 
WebAccess or Monitor is installed, you need to run a script that reconfigures the WebAccess 
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Application or the Monitor Application for the new Apache and Tomcat configuration and directory 
structure.

“Open Enterprise Server 1 to Open Enterprise Server 2” on page 3
“SUSE Linux Enterprise Server 9 to SUSE Linux Enterprise Server 10” on page 5
“Updating the WebAccess Application and the Monitor Application after the Operating System 
Upgrade” on page 6

4.1.1  Open Enterprise Server 1 to Open Enterprise Server 2

When you upgrade from Open Enterprise Server (OES) 1 to OES 2 with GroupWise installed on 
your OES server, you encounter package conflicts that must be resolved. A pop-up message appears 
immediately before the Installation Settings screen that informs you that the Delete Unmaintained 
Packages option is selected under Update Options. OES 2 considers GroupWise an “unmaintained 
package.” This means that, by default, your GroupWise software will be deleted as part of the 
upgrade process, unless you follow the instructions below.

1 Read the pop-up warning carefully, then click OK to close the pop-up.

The pop-up describes three possible actions you can take to resolve the GroupWise status as an 
unmaintained package. This procedure steps you through the second of the three possible 
actions. This alternative works most efficiently for preserving your GroupWise installation.

2 When ConsoleOne® is installed on the server:
The following message displays below the Packages link on the Installation Settings screen:
Cannot solve all conflicts. Manual intervention is required.

2a Click the Packages link.
The upgrade process checks for package conflicts, then displays the following message:
NOVLc1-1.3.6-1.i386 is locked and cannot be uninstalled.

2b Select Keep NOVLc1, then click OK - Try Again.
The upgrade process checks again for conflicts for NOVLc1 and displays one or more 
package-related warnings, providing you with alternatives for how to handle each conflict. 
The specific warnings you receive depend on the packages installed on the server you are 
upgrading. Therefore, warnings vary. Here are some examples:

NOVLc1-1.3.6-1.i386 cannot be installed due to missing 
dependencies.

novell-eguide-2.1.32.noarch cannot be installed due to 
missing dependencies.

The messages fall into two categories of problems:
Missing dependencies for ConsoleOne (the NOVLc1 package)
Missing dependencies for a product package other than ConsoleOne (for example, 
eGuide)

The following steps help you decide which action to take for each type of message.
2c If the message indicates missing dependencies for ConsoleOne (NOVLc1), select Ignore 

This Requirement Just Here.
2d If the message indicates missing dependencies for some other product package than 

ConsoleOne, and you are sure that you do not want that product package, select Delete 
package_name.
GroupWise 7 Support Pack 3 3
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WARNING: ConsoleOne is dependent on a variety of packages. Delete packages only 
when you are certain that they are not required by ConsoleOne. If in doubt, select Keep 
package_name.

2e When you have selected an action for each conflict message, click OK - Try Again.
The upgrade process checks again for conflicts for NOVLc1. Additional messages might 
be displayed for you to select actions to resolve the conflicts. This cycle repeats until all 
conflicts have been resolved, then you successfully reach the Packages page.

3 On the Packages page, select Search in the Filter field.
4 Search for the GroupWise packages that are installed on the server by typing the following in 

the Search field:
novell-groupwise

5 Click Search.
Depending on what GroupWise components are installed on the server, the search results 
include some of the following packages:
novell-groupwise-admin
novell-groupwise-agents
novell-groupwise-dbcopy
novell-groupwise-gwcheck
novell-groupwise-gwha
novell-groupwise-gwia
novell-groupwise-gwinter
novell-groupwise-gwmon
novell-groupwise-monitor
novell-groupwise-webaccess

6 Right-click the first GroupWise package in the list, then click All in This List > Keep.
This changes the status of each GroupWise package from Delete to Keep.

7 Search for the NOVLc1 package.
The NOVLc1 and NOVLc1Linuxjre packages should be listed and marked as locked. This 
means that they will not be deleted.

8 If these packages are marked with a Delete status, change their status to Keep.
9 Click Accept on the Packages page.

10 If you are presented with a font License Agreement, click Accept.
11 Click Continue to return to the Install Settings page.
12 Verify that the package conflict message is now gone from under the Packages link, then 

continue with the upgrade process.
13 After you have finished the upgrade, reinstall the NDSbase RPM that was originally installed 

with ConsoleOne.
The upgrade process removed it, but it is still needed by ConsoleOne.
13a In a Linux terminal window, log in as root, then change to the directory where you 

originally extracted the ConsoleOne files.
13b Change to the Linux subdirectory.
13c Use the following command to reinstall the NDSbase RPM:

rpm -ivh NDSbase-8.7.3.7-38.i386.rpm
7 Support Pack 3
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If you encounter problems with GroupWise after you have upgraded from OES 1 to OES 2, see TID 
3570778 in the Novell Knowledgebase  (http://www.novell.com/support/supportcentral) for 
assistance.

4.1.2  SUSE Linux Enterprise Server 9 to SUSE Linux Enterprise Server 10

When you upgrade from SUSE® Linux Enterprise Server (SLES) 9 to SLES 10 with GroupWise 
installed on your SLES server, you encounter package conflicts that must be resolved.

1 When ConsoleOne is installed on the server:

The following message displays below the Packages link on the Installation Settings screen:
Cannot solve all conflicts. Manual intervention is required.

1a Click the Packages link.
The upgrade process checks for package conflicts, then displays the following message:
NOVLc1-1.3.6-1.i386 is locked and cannot be uninstalled.

1b Select Keep NOVLc1, then click OK - Try Again.
The upgrade process checks again for conflicts for NOVLc1 and displays one or more 
package-related warnings, providing you with alternatives for how to handle each conflict. 
The specific warnings you receive depend on the packages installed on the server you are 
upgrading. Therefore, warnings vary. Here are some examples:

NOVLpkia-2.7.0-6.i386 is locked and cannot be 
uninstalled.

NOVLc1-1.3.6-1.i386 cannot be installed due to missing 
dependencies.

The messages fall into two categories of problems:
A locked package
Missing dependencies for ConsoleOne (the NOVLc1 package)

The following steps help you decide which action to take for each type of message.
1c If the message indicates a locked package, select Keep package_name.
1d If the message indicates missing dependencies for ConsoleOne (NOVLc1), select Ignore 

This Requirement Just Here.
1e When you have selected an action for each conflict message, click OK - Try Again.

The upgrade process checks again for conflicts for NOVLc1. Additional messages are 
displayed for you to select actions to resolve the conflicts. This cycle repeats until all 
conflicts have been resolved (approximately nine times), then you successfully reach the 
Packages page.

2 On the Packages page, select Search in the Filter field.
3 Search for the GroupWise packages that are installed on the server by typing the following in 

the Search field:
novell-groupwise

4 Click Search.
Depending on what GroupWise components are installed on the server, the search results 
include some of the following packages:
GroupWise 7 Support Pack 3 5
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novell-groupwise-admin
novell-groupwise-agents
novell-groupwise-dbcopy
novell-groupwise-gwcheck
novell-groupwise-gwha
novell-groupwise-gwia
novell-groupwise-gwinter
novell-groupwise-gwmon
novell-groupwise-monitor
novell-groupwise-webaccess

5 Right-click the first GroupWise package in the list, then click All in This List > Keep.
This changes the status of each GroupWise package from Delete to Keep.

6 Search for the NOVLc1 package.
The NOVLc1 and NOVLc1Linuxjre packages should be listed and marked as locked. This 
means that they will not be deleted.

7 If these packages are marked with a Delete status, change their status to Keep.
8 Click Accept on the Packages page.
9 If you are presented with a font License Agreement, click Accept.

10 Click Continue to return to the Install Settings page.
11 Verify that the package conflict message is now gone from under the Packages link, then 

continue with the upgrade process.
12 After you have finished the upgrade, reinstall the NICI RPM and the NDSbase RPM that were 

originally installed with ConsoleOne.
The upgrade process removed them, but they are still needed by ConsoleOne.
12a In a Linux terminal window, log in as root, then change to the directory where you 

originally extracted the ConsoleOne files.
12b Change to the Linux subdirectory.
12c Use the following commands to reinstall the RPMs:

rpm -ivh nici-version-i386
rpm -ivh NDSbase-version.i386.rpm

If you encounter problems with GroupWise after you have upgraded from SLES 9 to SLES 10, see 
TID 3570778 in the Novell Knowledgebase  (http://www.novell.com/support/supportcentral) for 
assistance.

4.1.3  Updating the WebAccess Application and the Monitor Application after the 
Operating System Upgrade

When you upgrade your Linux operating system, OES 2 installs new versions of Apache and 
Tomcat by default. SLES does not; you must install them manually by following the procedure in 
this section. In addition, the GroupWise 7 installations of the WebAccess Application and the 
Monitor Application must be modified to accommodate changes made in Apache and Tomcat. The 
WebAccess/Monitor Update script takes care of this process for you. This script is available with 
TID 3624780 in the Support Knowledgebase (http://www.novell.com/support/supportcentral).

1 If you have upgraded to SLES 10, use YaST to install Apache and Tomcat if they were not 
already installed on SLES 9:
7 Support Pack 3
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1a Start YaST, then provide the root password.
1b Click Software Management.
1c In the Search field, type Apache, click Search, then select apache2 from the list.
1d In the Search field, type Tomcat, click Search, then select tomcat5 from the list.

Apache 2 was part of your SLES 9 installation, so it should have been automatically 
upgraded. Tomcat changed from Tomcat 4 to Tomcat 5, so unless Tomcat 5 was installed 
on SLES 9, Tomcat 5 needs to be installed.

1e Click Accept.
1f Follow the prompts to install the needed packages to your SLES 10 server.

1g Exit YaST.
2 Download the WebAccess/Monitor Update script from TID 3624780 in the Novell Support 

Knowledgebase (http://www.novell.com/support/supportcentral) to a convenient location on 
your Linux server.

3 Change to the directory where you downloaded the script file.
4 Give the script file execute permissions:
chmod +x fixgwweb.sh

5 Run the script.
The script makes some slight reconfigurations of GroupWise files and directories that were 
originally set up when the WebAccess Application and the Monitor Application were installed 
on your previous version of Linux.

Apache 2: On OES 1 and SLES 9, Apache 2 used the mod_jk connector to facilitate 
communication between Apache and Tomcat. On OES 2 and SLES 10, Apache 2 uses the 
mod_proxy module instead. The WebAccess/Monitor Update script modifies the 
gw.conf file with this change. On SLES 10, the script also creates a symbolic link from 
/etc/opt/novell/gw/gw.conf to the new Apache 2 location of /etc/
apache2/conf.d/gw.conf.
Tomcat 5: On OES 1 and SLES 9, the WebAccess /var/opt/novell/gw directory 
was linked to /var/opt/novell/tomcat4/webapps/gw. The script changes this 
link to /var/opt/novell/tomcat5/webapps/gw. For Monitor, the /var/opt/
novell/gwmon directory now links to/var/opt/novell/tomcat5/webapps/
gwmon.

6 Start or restart Tomcat.

7 Start or restart Apache.

8 If you are upgrading to OES 2, you might receive the following message when starting Apache 
2:
Module "Jk" is not installed, ignoring.

OES 2: /etc/init.d/novell-tomcat5 restart

SLES 10: /etc/init.d/tomcat5 start

OES 2: /etc/init.d/apache2 restart

SLES 10: /etc/init.d/apache2 restart
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You can safely ignore this message, but you can use the following steps to eliminate it:
8a Start YaST, then provide the root password.
8b Click NetWork Services > HTTP Server.
8c On the Server Modules tab, select the jk module in the list of services, then toggle the 

status to Off.
8d Click Finish to save your change.
8e Exit YaST.

You should now be able to run WebAccess and Monitor successfully on your upgraded Linux 
operating system. 

4.2  Linux: Administration Software Installation Instructions

IMPORTANT: If you are installing the GroupWise software in a cluster, refer to the GroupWise 7 
Interoperability Guide (http://www.novell.com/documentation/gw7) for cluster-specific installation 
instructions before starting to install the Support Pack.

1 Download the GroupWise 7 SP3 Administration compressed tar file to a temporary directory 
on your Linux server:

gw703_full_lnx_us.tar.gz for English only
gw703_full_lnx_multi.tar.gz for multilingual

2 In a terminal window at your Linux server, change to the temporary directory, then use the 
following commands to uncompress and untar the downloaded file:
tar -xvzf filename.tar.gz

The files are extracted to the root of the directory.
3 Become root by entering sux and the root password.
4 Use the following command to start the GroupWise Installation program:
./install

5 Click Create or Update a GroupWise System.
6 Follow the on-screen instructions to create the GroupWise 7 SP3 software distribution 

directory and install the administration and agent software.
Update the primary domain first. Start the MTA in the primary domain. Then update secondary 
domains, followed by the post offices in each domain. Start each MTA and POA for each 
domain and post office. Then update the other GroupWise agents.
When you use the Linux GroupWise Installation program to install a Support Pack, use the 
Install option to install the updated RPM for each agent. Typically, you do not need to use the 
Configure option after installing updated agent software, if the agent configuration has not 
changed since the previous installation. (For an exception to this procedure, see Section 7.3.1, 
“Run Configure When Updating the Linux Agents,” on page 19). If you encounter a problem 
starting the updated agent, use the Configure option to update the configuration information.
For additional instructions, refer to the GroupWise 7 Installation Guide on the GroupWise 7 
Documentation Web site (http://www.novell.com/documentation/gw7).
7 Support Pack 3
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4.3  Linux: Cross-Platform Client Software Installation 
Instructions

1 Download the GroupWise 7 SP3 Client compressed tar file to a temporary directory on your 
Linux workstation:

gw703_client_lnx_us.tar.gz for English only
gw703_client_lnx_multi.tar.gz for multilingual

2 In a terminal window at your Linux workstation, change to the temporary directory, then use 
the following command to uncompress and untar the downloaded file:
tar -xvzf filename.tar.gz

The files are extracted to the root of the directory.
3 Run the GroupWise Setup program to install the GroupWise Cross-Platform client software:
./install

4 To start the Cross-Platform client after installation, click the GroupWise icon on your Linux 
desktop.

4.4  Macintosh: Cross-Platform Client Software Installation 
Instructions

1 Download the GroupWise 7 SP3 Client file to a temporary directory on your Macintosh 
workstation:

gw703_client_mac_ppc_us.dmg for English only, Mac OS* X
gw703_client_mac_ppc_multi.dmg for multilingual, Mac OS X
gw703_client_mac_intel_us.dmg for English only, Mac OS X on Intel*
gw703_client_mac_intel_multi.dmg for multilingual, Mac OS X on Intel

2 At your Macintosh workstation, browse to the file you downloaded.
3 Double-click the file to install the GroupWise Macintosh client.
4 To start the Cross-Platform client after installation, click the GroupWise icon on your 

Macintosh desktop.

5  Installation Issues
Section 5.1, “General Installation Issues,” on page 9
Section 5.2, “NetWare/Windows Installation Issues,” on page 10
Section 5.3, “Linux Installation Issues,” on page 11

Installation issues for individual GroupWise components are located under the heading for each 
component.

5.1  General Installation Issues
“Version Compatibility” on page 10
“GroupWise 7 Reinstallation” on page 10
GroupWise 7 Support Pack 3 9
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“WebAccess and Monitor on the Same Web Server” on page 10
“Web Clipping Application (PQA) Support with WebAccess and Monitor” on page 10
“Additional Installation Issues” on page 10

5.1.1  Version Compatibility

If you install GroupWise on multiple platforms, or if you run multiple versions (for example, 
GroupWise 6.5 and GroupWise 7 in the same GroupWise system), refer to the GroupWise Version 
Compatibility section in the GroupWise 7 Installation Guide (http://www.novell.com/
documentation/gw7) to make sure that the combinations you are using are supported. 

For example, you cannot run a GroupWise 7 client against a GroupWise 6.5 or earlier post office. 
Earlier POAs cannot support later GroupWise clients. However, you can run a GroupWise 6.5 or 
earlier client against a GroupWise 7 POA.

Also, you cannot run the GroupWise 6.5 or earlier snap-ins to ConsoleOne to access GroupWise 7 
databases or eDirectoryTM objects. You can use Admin Lockout Settings under Tools > GroupWise 
System Operations > System Preferences to specify the required version of the ConsoleOne snap-ins 
for each domain as needed.

5.1.2  GroupWise 7 Reinstallation

If you install GroupWise 7 components from a software distribution directory located on your local 
drive or a network drive and then try to update those components by installing from a CD, the 
installation fails by erroneously prompting for a disk:

Please insert the disk: 1

Uninstall the existing software, then install from the CD.

5.1.3  WebAccess and Monitor on the Same Web Server

The WebAccess Application, WebPublisher Application, and Monitor Application share a common 
library. If you are updating from an earlier GroupWise version and if you run these applications on 
the same Web server, you must update all three before any of them can work properly.

5.1.4  Web Clipping Application (PQA) Support with WebAccess and Monitor

Palm OS* devices are no longer supported in GroupWise 7. However, the Installation program still 
offers the opportunity to configure this feature. If you have been using a PQA in an earlier version of 
GroupWise, you can continue to do so, but it is no longer a supported feature.

5.1.5  Additional Installation Issues

Platform-specific installation issues are listed in separate sections below. Installation issues for 
individual GroupWise components are located under the heading for each component.

5.2  NetWare/Windows Installation Issues
“Software Distribution Directory Dependency” on page 11
“Problem Installing from a Windows XP Service Pack 2 Machine” on page 11
7 Support Pack 3
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5.2.1  Software Distribution Directory Dependency

When you create a new system and you are prompted for software to copy to the software 
distribution directory, select at least the agent and client software. The GroupWise Installation 
program launches the Agent Installation program and the Client Installation program. It currently 
must run those programs from the software distribution directory.

5.2.2  Problem Installing from a Windows XP Service Pack 2 Machine

When installing any GroupWise agent (Post Office Agent, Message Transfer Agent, Internet Agent, 
WebAccess Agent, Monitor Agent) to a NetWare server from a Windows XP machine where 
Service Pack 2 has been installed, you must have the Novell ClientTM 4.90 SP2 or later installed on 
the Windows machine. If you have an earlier Novell Client, the GroupWise Installation program 
claims that it cannot find some of the directories to which you want to install software.

5.3  Linux Installation Issues
“GroupWise Installation to Xen Guest on SUSE Linux Enterprise Server 10” on page 11
“Linux Text-Based Installation Program Compatibility with ssh on Windows” on page 11
“Upgrading from an Incomplete Software Distribution Directory” on page 11
“Moving a Library from NetWare or Windows to Linux” on page 12
“Moving a GroupWise 4.1 System from NetWare or Windows to Linux” on page 12

5.3.1  GroupWise Installation to Xen Guest on SUSE Linux Enterprise Server 10

When you install GroupWise on SLES 10 to a Xen* guest, you might receive the following error 
message:
The current window is not large enough to run install. Please resize 
the window and run install again.

At present, the SLES 10 Xen console window does not report its dimensions properly. To work 
around this:

1 Make sure that SSH is enabled on the Xen guest.
2 Open an X terminal window on the SLES 10 Xen host by using the following command:
ssh -X root@guest_ip_address

3 Run the GroupWise Installation program from the Xen host.

5.3.2  Linux Text-Based Installation Program Compatibility with ssh on Windows

The text-based GroupWise Installation program does not run on all Windows versions of ssh. An 
open source product named Putty that can be downloaded from the Internet free of charge is 
compatible with the text-based GroupWise Installation program. There are several Web sites where 
Putty is available for download.

5.3.3  Upgrading from an Incomplete Software Distribution Directory

All GroupWise components on a server must be updated at the same time. Therefore, if you are 
installing GroupWise 7 from a software distribution directory that does not contain RPMs for all the 
components installed on the server, you receive the following error:
GroupWise 7 Support Pack 3 11
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Install failed for an unknown reason (7)

The GroupWise 7 component cannot be updated because its RPM is not present in the software 
distribution directory. You can use the GroupWise 7 Administrator for Linux CD to update the 
server, then use Configure Administration to create a complete software distribution directory.

5.3.4  Moving a Library from NetWare or Windows to Linux

Issues related to uppercase letters and lowercase letters in directory names for libraries have been 
resolved, as described in TID 3697382: Document Management Case Change for GW7 SP3 in the 
Novell Support Knowledgebase (http://www.novell.com/support/supportcentral).

5.3.5  Moving a GroupWise 4.1 System from NetWare or Windows to Linux

The “Migrate” section of the GroupWise 7 Installation Guide provides instructions for moving from 
NetWare or Windows to Linux. If you are moving post offices and domains belonging to a 
GroupWise 4.1 system, you might need to manually rename the domain database (wpdomain.db) 
from uppercase to lowercase, along with all .dc files. In addition, subdirectories in post office and 
domain directories might need to be renamed to lowercase.

6  Administration Issues
Section 6.1, “General Administration Issues,” on page 12
Section 6.2, “NetWare/Windows Administration Issues,” on page 15
Section 6.3, “Linux Administration Issues,” on page 16

6.1  General Administration Issues
“ConsoleOne Snap-In Version Compatibility” on page 12
“Text Version of Global Signatures” on page 13
“Images in Global Signatures” on page 13
“Global Signatures on Empty Messages” on page 13
“Global Signatures and Flat Forwarding through the Internet Agent” on page 13
“Priming Caching Mailboxes” on page 13
“-601 SPI Exception Displays during Alias Migration” on page 14
“Server Names” on page 14
“Identity Manager Version Compatibility” on page 14
“Identity Manager Configuration Issue” on page 14
“Server-Based Anti-Virus Software” on page 14

6.1.1  ConsoleOne Snap-In Version Compatibility

After a domain has been updated to GroupWise 7, do not administer that domain with earlier 
versions of the GroupWise snap-ins to ConsoleOne. Doing so could result in the unintentional 
creation of duplicate e-mail IDs. 

The e-mail ID indexing scheme has been changed to allow the same e-mail ID to be used in different 
Internet domains within the same GroupWise system. This was prevented by the previous indexing 
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scheme. Because the check for uniqueness now works differently, you must use the GroupWise 7 
version of the ConsoleOne snap-ins when administering a GroupWise 7 domain to prevent the 
possibility of duplication.

6.1.2  Text Version of Global Signatures

In the original release of GroupWise 7, the text version of a global signature was generated 
automatically from the HTML version; you did not have any control over it. In GroupWise 7 
Support Packs, you can display and edit the text version as well as the HTML version. If you created 
global signatures in the original version of GroupWise 7, you should verify that the text version is 
what you want and modify it as needed. 

1 In ConsoleOne, click Tools > GroupWise System Operations > Global Signatures.
2 Select a global signature, then click Edit.
3 Modify the text version as needed.

For example, if the HTML version included an image, such as your company logo, you might 
want to add text to take the place of the image, such as the name of your company.
Click OK to save your changes.

4 Repeat this procedure for each global signature.

6.1.3  Images in Global Signatures

You might encounter a problem including an image file in a global signature if the path to the image 
is too long. This is a Java* problem. The easiest workaround is to move the image to a location with 
a shorter path. Another solution on Windows is to set the TMP environment variable to c:\temp 
before starting ConsoleOne.

6.1.4  Global Signatures on Empty Messages

Global signatures are not added to empty messages. Users can create empty messages by filling in 
the Subject field but not providing a message body. They can also create empty messages by 
forwarding messages as attachments.

6.1.5  Global Signatures and Flat Forwarding through the Internet Agent

If you enable global signatures, it disables flat forwarding through the Internet Agent because the 
signature is appended to each message. As an administrator, you must choose which is more 
important in your GroupWise system, global signatures or flat forwarding.

6.1.6  Priming Caching Mailboxes

With the GroupWise 7.0.2 default POA settings, the POA starts 6 TCP handler threads, 20% of 
which are available for priming (only 1 thread). If a user tries to prime his or her Caching mailbox 
when that one thread is already busy, the user receives the message Server Busy. If the 
GroupWise administrator uses ConsoleOne to increase the number of TCP handler threads and the 
percentage allowed for priming, so that 2 or more threads are available, the POA goes through a 
polling cycle before the changes go into effect. Use the POA Web console to make sure that the 
changes are in effect before starting to prime a second Caching mailbox, or use the POA Web 
console to change settings. The settings are put into effect immediately when they are made from the 
POA Web console. 
GroupWise 7 Support Pack 3 13
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For new POAs configured with GroupWise 7.0.3, the POA starts 10 handler threads, 30% of which 
are available for priming (3 threads) to prevent this problem in the future.

6.1.7  -601 SPI Exception Displays during Alias Migration

If the E-Mail Address field on the General page of a User object needs to be changed as a result of 
the information in the gateway alias, and if the User object cannot be found, a -601 SPI 
Exception displays and is written to the Alias Migration utility log file. This situation can arise 
when the association between the eDirectory object and the GroupWise object is broken for some 
reason. The association can be reestablished using Tools > GroupWise Utilities > GW / eDirectory 
Association > Associate Objects.

6.1.8  Server Names

When filling in a UNC Path field in ConsoleOne, you must specify the server name. You cannot use 
an IP address or DNS hostname.

6.1.9  Identity Manager Version Compatibility

Do not run a DirXML® or Identity Manager driver earlier than version 2.1.3 against a GroupWise 7 
system. Version 2.2.1 or later is recommended. Older drivers are not compatible. You can download 
the latest version of the GroupWise driver from the Novell Identity Manager Patches Web site (http:/
/support.novell.com/filefinder/20560/index.html).

6.1.10  Identity Manager Configuration Issue

Section 3.3.3: GroupWise WebAccess Templates in the Identity Manager Accessory Portlet 
Reference Guide (http://www.novell.com/documentation/idm35/agprtlt/data/agprtltspartmail.html) 
provides information for configuring GroupWise portlets. In particular, it instructs you to edit lines 
in the webacc.cfg file to appear as follows:
Security.UseClientIP.enable=false
Security.UseClientCookie.enable=false

In addition to these changes in the webacc.cfg file, you need to make the following change in 
ConsoleOne:

1 Browse to and select the Domain object.
2 Right-click the GroupWiseWebAccess object, then click Properties.
3 Click Application > Security.
4 Deselect Use client IP in securing sessions, then click OK.

The Use client IP in security sessions setting defaults to selected (true). If you do not deselect it, the 
“true” setting is written to the webacc.cfg file, overwriting your manual change to that file. If 
this happens, the WebAccess client prompts for login multiple times.

6.1.11  Server-Based Anti-Virus Software

If you run server-based anti-virus software, you should configure it so that it does not scan 
GroupWise directory structures such as domains and post offices, where file locking conflicts can 
create problems for the GroupWise agents. If you need virus scanning on GroupWise data, check the 
GroupWise Partner Products page (http://www.novell.com/partnerguide/p100031.html) for 
compatible products.
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6.2  NetWare/Windows Administration Issues
“Directory Names and Filenames” on page 15
“Novell Client File Caching” on page 15
“Unnecessary Login Prompt” on page 15
“GWTSA and Duplicate Source Directories” on page 15
“Quotas on NSS Volumes” on page 16
“TurboFat Compatibility” on page 16
“eDirectory Admin User Surname on Windows” on page 16

6.2.1  Directory Names and Filenames

All directory names in paths to GroupWise domains and post offices can consist of up to 8 
characters. 

Filenames can also consist of up to 8 characters, with extensions of up to 3 characters. Do not use 
long filenames for any files used by any GroupWise components. This requirement applies even to 
files that are not specific to GroupWise (such as SSL certificates and key files).

6.2.2  Novell Client File Caching

When you run ConsoleOne, Novell Client file caching should be turned off to protect database 
integrity.

1 Right-click the red N in the notification area, then click Novell Client Properties.
2 Click Advanced Settings, select File Caching, then select Off.
3 Click OK to save your change.

6.2.3  Unnecessary Login Prompt

If you are running ConsoleOne 1.3.6f with JRE* 1.5 or if you are running ConsoleOne 1.3.6h, 
ConsoleOne might prompt you to log in when it tries to attach to the domain, even if you are already 
logged in to the server where the domain is located. Click Cancel to close the two unnecessary 
dialog boxes. 

If you try to log in using these unnecessary prompts, you receive the following error:
NMAS: bad request syntax error - 1632 (0xffff9a0)

6.2.4  GWTSA and Duplicate Source Directories

The GroupWise Target Service Agent (GWTSA) handles situations where the same directory names 
are used for backups on different volumes by numbering the instances. For example:

Original GWTSA 
GroupWise System/[Dom]Provo2:
GroupWise System/[Dom]Provo2:

Support Pack GWTSA 
GroupWise System/1[DOM]Provo2:
GroupWise System/2[DOM]Provo2:
GroupWise 7 Support Pack 3 15
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Each instance is numbered and DOM is in all uppercase letters. After updating GWTSA with 
GroupWise 6.5 Support Pack 1 or later, you must re-create your backup jobs because the path has 
changed.

6.2.5  Quotas on NSS Volumes

If you use NSS volumes with quotas turned on, then you must turn on quotas on all GroupWise 
directories. Otherwise, you will receive No Disk Space errors.

6.2.6  TurboFat Compatibility

If you see E811 errors on the POA or the GroupWise client, a possible cause is that TurboFat is 
corrupting GroupWise database pointers. The solution is to turn off TurboFat.

To turn off TurboFat on NetWare 5.x servers, use turbodis.nlm.
To turn off TurboFat on NetWare 6.x servers, use tdis600.nlm.

These NLMTM programs disable TurboFat at startup.

6.2.7  eDirectory Admin User Surname on Windows

When you create a new eDirectory tree on Windows, the surname of the Admin user is 
automatically set to a single space. This can cause problem in some GroupWise situations. For best 
results, manually set the surname of the Admin user to something meaningful.

6.3  Linux Administration Issues
“NFS Not Supported” on page 16
“Pathnames and Filenames in Lowercase” on page 16
“eDirectory Admin User Surname on Linux” on page 16
“Unavailable Administration Features” on page 17

6.3.1  NFS Not Supported

Because of long-standing file lock issues with NFS*, you cannot use an NFS mount to mount a 
server file system where your GroupWise system is located to a workstation where you are running 
ConsoleOne. We recommend using an SMB mount instead.

6.3.2  Pathnames and Filenames in Lowercase

All directory names in paths to GroupWise domains and post offices should consist of lowercase 
letters. Filenames should also consist of lowercase letters. There are no length restrictions.

6.3.3  eDirectory Admin User Surname on Linux

When you create a new eDirectory tree on Linux, the surname of the Admin user is automatically set 
to a single space. This can cause problem in some GroupWise situations. For best results, manually 
set the surname of the Admin user to something meaningful.
7 Support Pack 3



novdocx (en)  11 D
ecem

ber 2007
6.3.4  Unavailable Administration Features

GroupWise 7 administration on Linux does not include the following features that are available in 
GroupWise 7 on NetWare and Windows:

Import/Export utility in ConsoleOne
Document Properties Management feature in ConsoleOne

7  Agent Issues
Section 7.1, “General Agent Issues,” on page 17
Section 7.2, “NetWare/Windows Agent Issues,” on page 19
Section 7.3, “Linux Agent Issues,” on page 19

7.1  General Agent Issues
“Agent Web Console Functionality in Firefox” on page 17
“New View Files Now Overwrite Existing View Files” on page 17
“POA Indexing Limitations” on page 18
“SOAP Port Number Not Replicated by the Original GroupWise 7 ConsoleOne Administrator 
Snap-In” on page 18
“Evolution Compatibility with the POA and SOAP” on page 18
“MTA /tcptrunkwidth Switch Obsolete” on page 18

7.1.1  Agent Web Console Functionality in Firefox

On the Links page of the MTA Web console in Firefox*, previous versions had a problem with the 
functionality of the Suspend and Resume buttons. Support Pack 2 or later resolves the problem. 
However, some browser settings need to be cleared in order for the fix to take effect. 

In Firefox:

1 Click Tools > Options.
2 Click Privacy, then click Settings.
3 Select Clear private data when closing Firefox, then click OK twice.
4 Exit Firefox, then start Firefox again.

7.1.2  New View Files Now Overwrite Existing View Files

When you update the POA software, updated view files are copied to the software distribution 
directory but not to post offices. This maintains any customizations you might have made in the 
view files. When you use the Refresh Views option under Tools > GroupWise Utilities > System 
Maintenance in ConsoleOne, the post office view files are updated from the software distribution 
directory. If you have created custom view files with the same names as standard view files, you 
must create backup copies so that your customized view files are not lost in the refresh process. 
After you refresh the views, you must restore your customized view files to the post office.
GroupWise 7 Support Pack 3 17
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7.1.3  POA Indexing Limitations

The POA’s QuickFinderTM indexing feature does not currently index PDF files or OpenOffice files.

7.1.4  SOAP Port Number Not Replicated by the Original GroupWise 7 ConsoleOne 
Administrator Snap-In

If you enabled SOAP in the original GroupWise 7 release, and if you changed the SOAP port 
number from its default of 7191, this information was not correctly replicated from the domain 
database to which ConsoleOne was attached to the post office database used by the POA for its 
configuration information. As a result, SOAP e-mail clients that relied on POA redirection 
(ngwnameserver) were not able to connect to the proper POA unless the correct IP address and 
port number were provided when starting the client.

In later GroupWise 7 Support Packs, successful POA redirection is critical to proper functioning of 
GroupWise Mobile Server. If you enabled SOAP in GroupWise 7 and changed the port number, you 
need to force the port number to replicate from the domain database to the post office database. 

1 Install the GroupWise Administrator snap-in to ConsoleOne from the Support Pack.
2 In ConsoleOne, browse to and right-click the POA object.
3 Click GroupWise > Agent Settings.
4 Deselect Enable SOAP, then click Apply.
5 Select Enable SOAP, then click OK.
6 Repeat this procedure for each POA in your GroupWise system.

By manually modifying the SOAP information, the SOAP information, including the port number, 
is written to the domain database and then properly replicated to the post office database so that 
redirection works properly for SOAP clients.

7.1.5  Evolution Compatibility with the POA and SOAP

Users might experience problems using EvolutionTM to connect to their GroupWise mailboxes if they 
are using Evolution 2.6.0 or earlier. In addition, earlier versions of Evolution can cause high 
utilization on GroupWise servers. To encourage users to update to the latest version of Evolution, 
you can use the /evocontrol switch in the POA startup file to configure the POA to allow only 
specified versions of Evolution. The /evocontrol switch takes either of the following parameters:
/evocontrol-"Evolution-1.10-yyyy-mm-dd"
/evocontrol-"Evolution-Data-Server-1.10-yyyy-mm-dd"

You can put up to 10 switch entries in the startup file, so that you can list as many as 10 versions of 
Evolution. Entries beyond 10 are ignored. You can view the current entries at the POA Web console 
with the other SOAP settings. The POA log file lists the settings in the Soap Session section.

7.1.6  MTA /tcptrunkwidth Switch Obsolete

Earlier versions of GroupWise and the default MTA startup file included the /tcptrunkwidth switch. 
This switch has not been functional for several releases and has not been included in the product 
documentation. If you have been using the /tcptrunkwidth switch in the MTA startup file, you 
should remove it. It is no longer performing the function that it did in earlier versions because the 
MTA now handles the trunk width tuning automatically.
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7.2  NetWare/Windows Agent Issues
“Potential CAP Port Conflict” on page 19

7.2.1  Potential CAP Port Conflict

By default, the POA uses 1026 for its CAP (Calendar Access Protocol) port. On some Windows 
2000 servers, port 1026 is already used by the Windows Task Scheduler or other Windows service. 
If this occurs, configure the POA to use a different CAP port by using the /capport switch in the 
POA startup file.

7.3  Linux Agent Issues
“Run Configure When Updating the Linux Agents” on page 19
“Linux Agents Not Starting Automatically” on page 19
“Non-root Agents on Open Enterprise Server for Linux Support Pack 2” on page 19
“Handling GroupWise Agent Core Files on Linux Servers” on page 19
“POA SOAP Protocol on Open Enterprise Server for Linux” on page 20
“libXm.so.3 Error” on page 20

7.3.1  Run Configure When Updating the Linux Agents

Normally, when you update your agent software with a Support Pack, you can use the Install Agents 
option in the GroupWise Installation program to install the updated agent software, but you do not 
need to use the Configure Agents option because your agents are already configured. However, in 
GroupWise 7 Support Packs, you should use Configure Agents after updating the agent software in 
order to obtain the updated grpwise script.

7.3.2  Linux Agents Not Starting Automatically

Under certain circumstances, the Linux agents to do not start automatically at system startup, even 
though you selected Launch GroupWise Agents on System Startup during installation. Use the 
following commands as root to correct the problem:
chkconfig grpwise off
chkconfig grpwise on

7.3.3  Non-root Agents on Open Enterprise Server for Linux Support Pack 2

On Novell Open Enterprise Server SP2, services such as IMAP and IMAP SSL, which require port 
numbers below 1025, cannot be initiated or restarted after the GroupWise agents are running as a 
non-root user. To initiate or restart those services, you must manually stop the services and then 
restart the GroupWise agents.

This also applies to SUSE Linux Enterprise Server 9 SP3, the version of SLES that is bundled with 
Open Enterprise Server SP2.

7.3.4  Handling GroupWise Agent Core Files on Linux Servers

When the POA, the MTA, or the Internet Agent starts, it creates a file named process_id.pid in 
the same directory where log files for the agent are created. The process_id.pid file includes 
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the build date of the agent that created the core file. When a GroupWise agent creates a core file, it is 
always named core.process_id. If you need to submit a core file to Novell Support, please 
include the corresponding process_id.pid file so that Novell Support can determine the 
specific agent build that created the core file. Old process_id.pid files can be manually deleted 
along with their corresponding core files.

7.3.5  POA SOAP Protocol on Open Enterprise Server for Linux

On OES Linux SP1, the Linux POA does not currently support the SOAP protocol when running as 
a non-root user. However, it does support the SOAP protocol when running as root. 

On OES Linux SP2, the Linux POA does support the SOAP protocol when running as a non-root 
user, as well as when running as root.

7.3.6  libXm.so.3 Error

If you try to start the Linux POA or MTA using the --show switch on a server where The X Window 
System* and Open Motif* are not running, you receive the following error:
libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the POA or MTA 
with the --show switch. If you start the POA or MTA without the --show switch, you can use the 
agent’s Web console to monitor the agent from your Web browser.

8  Client Issues
Section 8.1, “Client Shared Folder Security Issue,” on page 20
Section 8.2, “Windows Client Issues,” on page 21
Section 8.3, “Cross-Platform Client Issues,” on page 23
Section 8.4, “Outlook Connector Issues,” on page 24

8.1  Client Shared Folder Security Issue
A security vulnerability exists in the GroupWise Windows Client API that can allow programmatic 
access to non-authorized email under certain conditions. The attacker must first authenticate to 
GroupWise and be a recipient of a shared folder from another user. The attacker could then exploit 
the vulnerability to gain unauthorized access to non-shared email in the mailbox of the sharer.

Users that have shared folders with other users can protect their e-mail by removing shared access 
until remedial steps have been completed.  It is not necessary to delete the contents of the shared 
folders and they can be re-shared after the administrator has locked out older client versions. To 
remove shared access to a folder, select the shared folder, click File > Sharing, select Not Shared, 
then click OK.

Administrators should lock out earlier versions of the GroupWise client in ConsoleOne in post 
offices where shared folders are in use.

1 Right-click each Post Office object, then click Properties.
2 Click GroupWise > Client Access Settings. 
3 Select Minimum Client Release Version, specify 7.0.3, then click OK.
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4 Repeat this procedure for each post office in your GroupWise system where shared folders are 
in use.

If you are running a mixed environment of GroupWise 6.5 and 7 clients, lock out based on the client 
release date rather than the client version. The recommended release date should be 9 Mar 2008 in 
order to ensure that your system is not vulnerable.

8.2  Windows Client Issues
“Error Messages When You Install GroupWise Windows Client” on page 21
“Windows XP Service Pack 2” on page 21
“Windows XP and Administrator Users” on page 22
“Missing Global Signatures on Empty Messages” on page 22
“Limited iCal Interoperability with External Systems” on page 22
“Can’t Set a Primary Archive Computer” on page 22
“Can’t Administer Distribution Lists in Caching Mode” on page 22
“Screen Flickers When Scrolling a Message” on page 22
“Can’t Switch Modes When Using Microsoft Anti-Spyware” on page 22
“Address Books Do Not Display in GroupWise When Installing GroupWise After Outlook 
2003” on page 22
“Notify Alarms Disappear for Appointments” on page 23
“Updated JAWS Script Available” on page 23
“Spyware Detection Software Causes Installation to Not Work” on page 23
“VMware and Proxy” on page 23

8.2.1  Error Messages When You Install GroupWise Windows Client 

If you install the GroupWise Windows client with Outlook* XP already installed, an error message 
appears:
Either there is no default mail client or the current mail client 
cannot fulfil the messaging request. 
Please run Microsoft Outlook and set it as the default mail client.

In addition, if you open the Address Book, the GroupWise client crashes.

To fix the problem, run win32\wms\nt\us\wms.exe from the GroupWise installation 
directory, then restart the client.

8.2.2  Windows XP Service Pack 2

Installing Windows XP Service Pack 2 enables the Windows Firewall by default. The default 
Windows Firewall configuration blocks UDP (User Datagram Protocol). GroupWise is dependent 
on UDP for several key features such as listing new messages in your Mailbox, displaying 
notifications, and performing Busy Searches. To reconfigure the Windows Firewall so that it does 
not interfere with GroupWise functionality, follow the instructions in TID 10094089 in the Novell 
Support Knowledgebase (http://www.novell.com/support/supportcentral).
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8.2.3  Windows XP and Administrator Users

If GroupWise 7 has already been installed on a workstation by an administrator user, and if a 
GroupWise 7 Support Pack is installed by a different administrator user, a second instance of 
GroupWise is installed and the first instance is not updated. To fix this problem, go to the Control 
Panel, then double-click Add/Remove programs. If GroupWise is listed twice, remove the obsolete 
instance.

8.2.4  Missing Global Signatures on Empty Messages

If you send a message with a subject only (no message body), a global signature is not appended. 
This is working as designed. The presence of a global signature on a message with an empty 
message body would prevent the Internet Agent /flatfwd switch from functioning correctly. 

8.2.5  Limited iCal Interoperability with External Systems

GroupWise might not handle iCal attachments correctly if they are received from a non-GroupWise 
external system. 

In particular, iCal appointments sent from non-GroupWise external systems (except Microsoft* 
Exchange) display as all-day appointments instead of All Day Events. Because of this, such 
appointments display in the Appointment pane instead of the All-Day-Events pane.

8.2.6  Can’t Set a Primary Archive Computer

Currently there is no way to set one computer as a primary archive. This can result in multiple 
archives if you use GroupWise on different computers.

8.2.7  Can’t Administer Distribution Lists in Caching Mode

In Online mode, if you have been granted rights to modify a distribution list, you can edit that 
distribution list in the GroupWise Address Book. In Caching mode, you cannot edit the distribution 
list in the GroupWise Address Book. However, if you go into the Address Selector in a new 
message, you can administer the distribution list from there.

8.2.8  Screen Flickers When Scrolling a Message

If you use ClearType to smooth the edges of screen fonts and have an LCD display, your screen 
might flicker when scrolling in a text message.

8.2.9  Can’t Switch Modes When Using Microsoft Anti-Spyware

If you are using Microsoft’s Anti-Spyware software, and you try to switch modes, GroupWise does 
not close. You must manually close GroupWise to switch modes. 

8.2.10  Address Books Do Not Display in GroupWise When Installing GroupWise 
After Outlook 2003

The address books do not display in GroupWise if you install GroupWise for the first time after you 
have installed Outlook 2003. To resolve the problem, uninstall Outlook 2003 before you install 
GroupWise for the first time.
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8.2.11  Notify Alarms Disappear for Appointments

After your account has been moved from one post office to another, your Notify alarms disappear 
for appointments. To get your Notify alarms back, you need to re-create all the alarms manually. For 
information on setting alarms for appointments, see the GroupWise client help.

8.2.12  Updated JAWS Script Available

Users of the JAWS* screen reader should install the new JAWS script available in GroupWise 7. 
Follow the instructions in the \client\jaws\gw_jaws_readme.txt file to install the JAWS 
script and other files on your workstation. This JAWS script includes Section 508 accessibility bug 
fixes that have occurred since the script was updated for GroupWise 6.5 Support Pack 3.

8.2.13  Spyware Detection Software Causes Installation to Not Work

If you have spyware detection software installed on your Windows computer, the GroupWise client 
for Windows might not install properly. Disable the spyware detection software before you install 
the GroupWise client for Windows.

8.2.14  VMware and Proxy

If you run the GroupWise Windows client in a VMware* virtual machine, you might receive an 
8503 error when you try to proxy to another user’s mailbox or display a Multi-User Calendar. To 
eliminate this problem, you need to disable the VMware adapters on your Windows workstation.

1 Right-click My Network Places, then click Properties.

In the list of LAN connections, you see one or more VMware adapters.
2 Right-click each adapter, then click Disable.

8.3  Cross-Platform Client Issues
“Items Forwarded from the GroupWise Connector for Outlook Do Not Open” on page 23
“Running as root in Caching Mode” on page 23
“Mailbox Size Limits Not Recognized” on page 24
“Bold Not Displaying on Macintosh” on page 24
“Archiving Over the Network” on page 24
“No Progress Bar Displayed When a Database Is Rebuilt” on page 24
“Focus Is in the Wrong Place When Creating a Reply on Macintosh” on page 24
“WebRenderer Not Available on Mac OS X on Intel” on page 24

8.3.1  Items Forwarded from the GroupWise Connector for Outlook Do Not Open

If you receive an item that was forwarded from the GroupWise Connector for Outlook, the item does 
not open in the Macintosh version of the Cross-Platform client.

8.3.2  Running as root in Caching Mode

If you run the Cross-Platform client in Caching mode as root on Linux, you might encounter 
synchronization problems with your master mailbox when you next run as a regular user. If pending 
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requests from the root session remain when you log in as a regular user, regular user requests get 
backed up behind the root requests, which cannot be processed while you are logged in as a 
regular user. To resolve any problems, run the client as root again so that all messages are 
synchronized, then run as a regular user thereafter to prevent further problems.

8.3.3  Mailbox Size Limits Not Recognized

The Cross-Platform client does not recognize the mailbox size limits set in ConsoleOne (Tools > 
GroupWise Utilities > Client Options > Send > Disk Space Management).

8.3.4  Bold Not Displaying on Macintosh

If you have installed Microsoft Office or Internet Explorer on your Macintosh, new messages might 
not display as bold in your mailbox. To resolve the problem, disable your user fonts, which are 
typically duplicates of your system fonts, or update to JVM* 1.4.2 Update 1 or later.

8.3.5  Archiving Over the Network

Archiving with the Cross-Platform client can only be done to your local computer hard drive. 

8.3.6  No Progress Bar Displayed When a Database Is Rebuilt

When prompted to rebuild your database, there is no progress indicator displayed during the rebuild 
process.

8.3.7  Focus Is in the Wrong Place When Creating a Reply on Macintosh

When you click Reply on Macintosh, you cannot just type the message. You must move the mouse 
cursor to the message body window of the reply message before you can start typing. 

8.3.8  WebRenderer Not Available on Mac OS X on Intel

The improved rendering of HTML in the WebAccess client is not available on Mac OS X on Intel 
because the WebRenderer* product that has been incorporated into GroupWise is not yet available 
for Mac OS X on Intel.

8.4  Outlook Connector Issues
“Outlook 2007 Compatibility” on page 24

8.4.1  Outlook 2007 Compatibility

The GroupWise 7 Connector for Microsoft Outlook cannot be installed with Outlook 2007. If you 
run the Outlook Connector Setup program in this environment, you receive the following message:
A version of Outlook compatible with the GroupWise Connector cannot be 
found. Install Outlook and run this install again.

The Outlook Connector is not supported with Outlook 2007.

9  WebAccess Issues
Section 9.1, “General WebAccess Issues,” on page 25
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Section 9.2, “NetWare/Windows WebAccess Issues,” on page 28
Section 9.3, “Linux WebAccess Issues,” on page 32

9.1  General WebAccess Issues
“GroupWise 7.0.3 WebAccess Compatibility with Earlier Versions of WebAccess” on page 25
“WebAccess Compatibility with Virtual Office 1.5 and Earlier” on page 25
“WebAccess Compatibility with Novell exteNd” on page 26
“Browser Cache Issue” on page 26
“Login Page Reappears after Successful Login” on page 26
““Login Is Not Current” Error” on page 26
“Pop-Up Blocker Issue” on page 27
“Recommendation for Tomcat Memory Allocation (Heap Size)” on page 27
“Preventing Web Server Directory Browsing” on page 27
“Preventing Unauthenticated Template Access” on page 27
“Updates to WebAccess Templates” on page 27
“GroupWise 6.5 Frame Templates No Longer Supported” on page 28
““The Page Cannot Be Displayed” Error” on page 28
“Blank WebAccess Address Book on Internet Explorer” on page 28
“Document Viewer Agent Cache Compatibility” on page 28
“Document Viewer Agent /template Switch” on page 28

9.1.1  GroupWise 7.0.3 WebAccess Compatibility with Earlier Versions of WebAccess

Before GroupWise 7.0.3, you could successfully run different versions of the WebAccess Agent and 
the WebAccess Application together. For example, you could install a new version of the 
WebAccess Application on your Web server while still running the previous version of the 
WebAccess Agent for the domain. 

Starting in GroupWise 7.0.3, the recommended update procedure is to update all the WebAccess 
Agents in your GroupWise system first, then update all the WebAccess Applications. Long-term use 
of the mixed-version configuration is not recommended. You must update both the WebAccess 
Agent and the WebAccess Application to the same version in order to ensure proper functioning of 
the GroupWise 7.0.3 WebAccess client.

Running a new WebAccess Application with an older WebAccess Agent is no longer supported.

9.1.2  WebAccess Compatibility with Virtual Office 1.5 and Earlier

If you access the WebAccess client through Virtual Office 1.5 or earlier, you might see the old 
WebAccess client interface rather than the new one. To resolve this problem, see TID 10098412 in 
the Novell Support Knowledgebase (http://www.novell.com/support/supportcentral).

9.1.3  WebAccess Compatibility with Novell exteNd

Before GroupWise 7, WebAccess stored its default user interface files in the following directory on 
the Web server:
GroupWise 7 Support Pack 3 25
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tomcat_root/webapps/gw/WEB-INF/classes/com/novell/webaccess/
                                                      templates/frames

In GroupWise 7, the user interface files are stored in the css subdirectory of templates rather than 
the frames subdirectory.

If you have exteNdTM portlets configured to use WebAccess, you must copy some of the exteNd 
template files from the frames directory into the css directory. Refer to the Novell exteNd 
documentation (http://www.novell.com/documentation/extend5) to determine which exteNd 
template files you should copy to the css directory. 

IMPORTANT: Do not copy the entire contents of the frames directory into the css directory; 
this damages the new GroupWise 7 WebAccess user interface.

In addition, modify the WebAccess URL in the exteNd Portal Preferences from:

http://Web_server_address/servlet/webacc

to:

http://Web_server_address/gw/webacc

9.1.4  Browser Cache Issue

After the WebAccess software has been updated, users’ browsers might pull old WebAccess files 
from the local cache rather than using the updated files that have just been installed. The results are 
unpredictable, including not being able to compose an item, reply, and so on. To resolve such 
problems, users need to clear the browser cache and then log in to the WebAccess client again.

9.1.5  Login Page Reappears after Successful Login

If the WebAccess login page appears in one or more of the frames (for example, the Folder list or the 
Item list) after a WebAccess user has successfully logged in, the user is probably accessing 
WebAccess through one or more proxy servers.

To prevent this problem:

1 In ConsoleOne, right-click the WebAccess Application object (GroupWiseWebAccess), then 
click Properties.

2 Click Application > Security, then deselect Use Client IP in Securing Sessions. 
For information about this option, click Help on the Environment page.

3 Click OK to save the change.

9.1.6  “Login Is Not Current” Error

If you are already logged in to the WebAccess client and you try to log in again without logging out 
first, you receive the “Login In Not Current” error. This is working as designed for security 
reasons.
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9.1.7  Pop-Up Blocker Issue

Very occasionally, a pop-up blocker can prevent you from opening messages in the WebAccess 
client. If this happens, you can turn off the pop-up blocker or use a different one. Many pop-up 
blockers are available.

9.1.8  Recommendation for Tomcat Memory Allocation (Heap Size)

If you are using the Tomcat servlet engine with GroupWise WebAccess, the maximum memory 
allocation (heap size) for Tomcat should be at least 128 MB. The maximum memory allocation is set 
by using the -Xmx parameter when starting Tomcat (for example, -Xmx128m).

9.1.9  Preventing Web Server Directory Browsing

If your Web server is configured to allow directory browsing, it is possible for a user to access the /
com directory of your Web server and browse downward from there. There is no confidential 
information located in any of the directories that are accessible in this manner. 

However, if you want to prevent access, you can change the configuration of your Web server. For 
example, if you are using Apache, you can modify the httpd.conf file to remove the access that 
is provided by default. Locate the section that provides directory options for the htdocs directory. 
Either remove the Indexes option from the Options directive or place a minus (-) in front of it. 
Restart Apache to put the change into effect.

9.1.10  Preventing Unauthenticated Template Access

Under certain very specific circumstances, it is possible for a user to view WebAccess template files 
from a Web browser without logging in to WebAccess. There is no confidential information located 
in any of the template files that are accessible in this manner. 

Starting with GroupWise 6.5 Support Pack 4, a line was added to the webacc.cfg file to prevent 
such access:

Templates.requireAuthentication=true

With this setting, unauthenticated users have no access to any WebAccess template files except for 
the Login page. If you have customized WebAccess templates for your own specialized use, this 
setting causes your templates to be inaccessible, even if GroupWise authentication was not 
previously required. You can turn off the authentication requirement by changing the line in the 
webacc.cfg file to:

Templates.requireAuthentication=false

9.1.11  Updates to WebAccess Templates

If you have created your own customized versions of the WebAccess send.inc and 
msgitem.htt templates, you need to make the following changes to these files in order for them 
to be compatible with GroupWise 7:

Do not use the Url.Item.Reply.to and Url.Item.Reply.cc variables to pass and post names in a 
reply message’s To and CC fields. Instead, use Item.toFullID and Item.ccFullID (or 
Item.toName or Item.ccName).
When issuing an Item.Read action for a reply, set the Item.Reply parameter to either “sender” 
(to reply only to the sender) or “all” (to reply to all).
GroupWise 7 Support Pack 3 27
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9.1.12  GroupWise 6.5 Frame Templates No Longer Supported

In GroupWise 7, the GroupWise 6.5 frame template files were still included in the GroupWise 7 
software image. Some users for whom the GroupWise 7 WebAccess client performance was 
unacceptably slow returned to using the GroupWise 6.5 frame template files in their GroupWise 7 
WebAccess installations.

Because the performance issues in the WebAccess client have been resolved in GroupWise 7 
Support Packs, the Installation program does the following when you install the WebAccess 7 
software from a Support Pack over the original GroupWise 7 software:

Deletes the frames entry from the user interfaces list (ConsoleOne > WebAccess Application 
object > Application > Templates > Define User Interfaces). 
Resets the default user interface to Standard HTML by using the css templates.
Moves the GroupWise 6.5 template files into a backup directory.
Installs the new css template files to the templates directory of your Web server.

If you were using the GroupWise 6.5 frame templates with your GroupWise 7 installation, please do 
not continue to do so.

9.1.13  “The Page Cannot Be Displayed” Error

On older versions of Internet Explorer*, users might receive this message after the WebAccess 
software has been updated. See TID 10081268 in the Novell Support Knowledgebase (http://
www.novell.com/support/supportcentral) for instructions to correct the problem. Update to the latest 
version of Internet Explorer to avoid the problem.

9.1.14  Blank WebAccess Address Book on Internet Explorer

On Internet Explorer, when you exit from Address Book Options in the WebAccess Address book, 
the Address Book page might be blank. Press F5 (Refresh) to redisplay the Address Book.

9.1.15  Document Viewer Agent Cache Compatibility

The cache created by the Document Viewer Agent is not compatible with the cache previously used 
with WebPublisher. Old WebPublisher cache directories should be removed from servers where the 
Viewer Agent is installed.

9.1.16  Document Viewer Agent /template Switch

The Document Viewer Agent startup file (gwdva.dva) lists a /template startup switch that is not 
yet implemented.

9.2  NetWare/Windows WebAccess Issues
“WebAccess Installation Error on Windows Workstations” on page 29
“WebAccess Service Fails to Start on Windows Servers” on page 29
“Novell iManager Compatibility on Windows” on page 29
“WebAccess Stops Responding on NetWare” on page 29
“GroupWise 6.5 Upgrade on NetWare” on page 29
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“New NetWare and Windows WebAccess URLs” on page 29
“Web Server File Cleanup Because of a URL Change” on page 31
“Problem Downloading Large Attachments” on page 31
“Memory Problem” on page 31
“Security Issue with WebAccess and Internet Explorer 5.0” on page 31
“Viewer Agent Issues on NetWare” on page 32

9.2.1  WebAccess Installation Error on Windows Workstations

If you receive an error during installation indicating that the nvweb.dll file cannot be found, 
update the workstation to the latest Novell Client. The Novell Client is available for download from 
the Novell Downloads Web site (http://download.novell.com).

9.2.2  WebAccess Service Fails to Start on Windows Servers

If you install the WebAccess Agent as a Windows service, reboot the server, and then do a 
workstation login as an Administrator, the WebAccess Agent service might fail to start. If this 
occurs, update to the latest Novell Client. The Novell Client is available for download from the 
Novell Downloads Web site (http://download.novell.com).

9.2.3  Novell iManager Compatibility on Windows

If WebAccess and Novell iManager are installed on the same Windows 2000/2003 server, iManager 
might stop working. Because WebAccess installs and configures its own Tomcat and Jakarta 
connector, it is preferable to install it on a server where Tomcat is not already in use by another 
program.

9.2.4  WebAccess Stops Responding on NetWare

WebAccess might stop responding for a period of time on NetWare. It might or might not resume 
operation. To resolve this problem, update to the latest Winsock patch available on the Novell 
Downloads site (http://download.novell.com).

9.2.5  GroupWise 6.5 Upgrade on NetWare

If the GroupWise 6.5 WebAccess Application is running on the server where you plan to install 
GroupWise 7 WebAccess, you should manually stop WebAccess, the Web server, and Tomcat before 
starting the GroupWise 7 installation. Under certain circumstances, the WebAccess Installation 
program cannot stop them for you.

9.2.6  New NetWare and Windows WebAccess URLs

Existing users of WebAccess are accustomed to accessing the following URLs on NetWare and 
Windows Web servers:

Web Services page: Default index.html file of the Web server

WebAccess: http://web_server_address/servlet/webacc

WebPublisher: http://web_server_address/servlet/webpub
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The WebAccess URLs on NetWare and Windows Web servers are now the same as the URLs used 
on Linux:

To keep users’ browser bookmarks from being broken, you should redirect the old URLs to the new 
URLs. Follow the instructions below for your Web server.

Apache

1 Change to the conf subdirectory of the Apache root directory (for example, 
\apache2\conf.

2 Edit the Apache configuration file for GroupWise.
On NetWare 6, the Apache configuration file is gwapache.conf. On NetWare 6.5, the 
Apache configuration file is gwapache2.conf.

3 Add the following line:
redirect permanent /servlet/webacc http://web_server_address/
                                                            gw/webacc 

4 If you use WebPublisher, add the following additional line:
redirect permanent /servlet/webpub http://web_server_address/
                                                            gw/webpub 

5 Save the file, then exit the editor.
6 Restart Apache to put the redirections into effect.

Internet Information Server (IIS)

1 Change to the inetpub\wwwroot subdirectory of the IIS root directory (for example, 
c:\inetpub\wwwroot)

2 Create a subdirectory named servlet.
3 Under the servlet subdirectory, create a subdirectory named webacc.
4 If you use WebPublisher, create a second subdirectory named webpub.
5 In IIS Manager, expand the tree in the left pane to display Default Web Site under Web Sites.

Under Default Web Sites, you should see the servlet subdirectory you created in Step 2.
6 Expand the servlet subdirectory to display the webacc subdirectory (and optionally, the 
webpub subdirectory) that you created in Step 3.

7 Right-click the webacc subdirectory, then click Properties.
8 Click Directory, select A Redirection to a URL, then type /gw/webacc in the associated field.
9 Select A Permanent Redirection for This Resource, then click OK to save your changes.

10 If you use WebPublisher, repeat Step 7 through Step 9, using webpub in place of webacc.
11 Restart the IIS Web server to put the redirections into effect.

GroupWise-specific 
Web Services page: 

http://web_server_address/gw/index.html

WebAccess: http://web_server_address/gw/webacc

WebPublisher: http://web_server_address/gw/webpub
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Netscape Enterprise Server for NetWare

For redirection instructions, search the Novell Support Web site (http://www.novell.com/support).

9.2.7  Web Server File Cleanup Because of a URL Change

As part of the change from /servlet/webacc to /gw/webacc, the WebAccess Installation 
program installs the WebAccess Application files into the servlet container (gw) but it does not 
remove old servlet and htdoc files located under the ROOT container of the servlet and the Web 
server. Therefore, you might want to manually delete the following directories and files:
sys:\apache2\htdocs\com
sys:\apache2\htdocs\index.html (if customized for GroupWise)
sys:\apache2\htdocs\novell.html (if index.html was not customized)
sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapfilt.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapjdk.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njgwap.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njweb.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\SpellServlet.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\web.xml

You should definitely delete web.xml, because it might cause the WebAccess, WebPublisher, and 
Monitor Applications to run in both the old and new locations. Also, if you have customized the 
GroupWise template files, you should copy the contents of the template subdirectories under:

sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com\novell

to the corresponding templates subdirectories under:

sys:\tomcat\4\webapps\gw\WEB-INF\classes\com\novell

9.2.8  Problem Downloading Large Attachments

On NetWare 6.5 Support Pack 5, you might need to install a Winsock patch that enables users to 
download large attachments when they are using SSL connections to WebAccess. For a workaround, 
see TID 10100680 in the Novell Support Knowledgebase (http://www.novell.com/support/
supportcentral).

9.2.9  Memory Problem

On NetWare 6.5 Support Pack 5, you might receive one of the following error messages on the 
server where the WebAccess Agent is running:
Server logical address space is running low ...
Short term memory allocator is out of memory ...
Cache memory allocator out of available memory ...

A patch for this problem is available in TID 2973639 in the Novell Support Knowledgebase (http://
www.novell.com/support/supportcentral).

9.2.10  Security Issue with WebAccess and Internet Explorer 5.0

When using Internet Explorer 5.0 to view messages through WebAccess, URLs to messages become 
part of the History cache and can be read by other users who have access to the same workstation. 
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For solutions to this problem, see TID 10056452 in the Novell Support Knowledgebase (http://
www.novell.com/support/supportcentral).

9.2.11  Viewer Agent Issues on NetWare

On NetWare, the Viewer Agent requires at least 1 GB of memory for running about 5 worker 
processes. By default, 5 processes are started.
On NetWare, you must install the latest Support Pack for your version of NetWare in order to 
have the correct version of clib.nlm. 
On NetWare, Memory Protection Fault Cleanup must be set to On in order for the Viewer 
Agent worker processes to recover successfully when a document fails HTML conversion.
On NetWare, when a document fails HTML conversion and its worker process dies, NetWare 
creates a small file named core*.dmp in the server’s root directory. You should periodically 
delete these files.

9.3  Linux WebAccess Issues
“WebAccess on SUSE Linux Enterprise Server 10” on page 32
“Novell Distribution of Apache and Tomcat” on page 32
“Prolonged “Please Wait” Message during Installation” on page 33
“Installation Security” on page 33
“Re-installation Issue” on page 34
“--httpport Switch Not Listed in webac70a.waa File” on page 34
“Viewer Agent Issues on Linux” on page 34
“WebPublisher Configuration” on page 34
“Commented Lines in Configuration Files” on page 34
“WebAccess Client Help Displays Incorrectly in Firefox on Linux” on page 34

9.3.1  WebAccess on SUSE Linux Enterprise Server 10

SUSE Linux Enterprise Server 10 uses Tomcat 5 rather than Tomcat 4. It also uses the 
MOD_PROXY module rather than the MOD_JK connector. Installation instructions that 
compensate for these differences are available in TID 3248145 in the Novell Support 
Knowledgebase (http://www.novell.com/support/supportcentral). 

9.3.2  Novell Distribution of Apache and Tomcat

GroupWise 7 on Linux includes a Novell distribution of Apache and Tomcat that you can install 
along with the WebAccess Application if you do not already have Apache and Tomcat running on 
that server. The Novell distribution relies on OpenSSL libraries. If OpenSSL is not already installed 
on the server where you plan to install the Novell distribution of Apache and Tomcat, you can obtain 
it from the OpenSSL Project (http://www.openssl.org). Download and build OpenSSL for your 
version of Linux before installing the Novell distribution of Apache and Tomcat.

The Novell distribution is installed in the following directories:
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It is started by using the following customized commands:

The WebAccess Installation program lets you choose whether you want to install the Novell 
distribution. During installation, select Install WebAccess Application with Apache and Tomcat if 
you want to install the Novell distribution. Select Install WebAccess Application if you do not want 
to install the Novell distribution of Apache and Tomcat because you have an existing Apache and 
Tomcat installation that you want to use with WebAccess.

NOTE: If you are installing on Novell Open Enterprise Server (OES), the option to install with 
Apache and Tomcat is not available.

If you install the Novell distribution on a server where a standard distribution of Apache and Tomcat 
is already installed and running, you will encounter a port conflict on port 80. You can resolve the 
port conflict by choosing to run one distribution or the other, or you can reconfigure one distribution 
or the other.

To reconfigure the Novell distribution to use a different port number, edit the httpd.conf file in 
the /etc/opt/novell/httpd/conf directory. Locate the following line:

Listen 80

Change the port number to a something that is not already being used on the server, then save and 
exit the file.

9.3.3  Prolonged “Please Wait” Message during Installation

On slower Linux machines, if you select Install WebAccess Application with Apache and Tomcat, 
your machine might appear to hang on the “Please Wait” message. Apache and Tomcat are 
being installed while the “Please Wait” message is displayed, before the WebAccess 
Application installation begins.

9.3.4  Installation Security

During installation, the Linux WebAccess Installation program requires access to eDirectory by way 
of LDAP authentication. The LDAP Group object includes an option named Require TLS for Simple 
Binds with Password, which is enabled by default. With this option enabled, you must provide the 
LDAP server’s trusted root certificate, which must be exported from the LDAP server, in order for 
LDAP authentication to take place (typically on port 636) during installation of the WebAccess.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple Binds 
with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear text 
(typically on port 389), during installation of WebAccess. After disabling the option, restart 

Apache: /var/opt/novell/http and 
/etc/opt/novell/http

Tomcat: /var/opt/novell/tomcat4 and 
/etc/opt/novell/tomcat4

Tomcat: /etc/init.d/novell-tomcat4 start

Apache: /etc/init.d/novell-httpd start
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eDirectory, install WebAccess, then re-enable Require TLS for Simple Binds with Password and 
restart eDirectory again.

9.3.5  Re-installation Issue

If you install Linux WebAccess in an eDirectory context where the WebAccess objects already exist, 
a message informs you that you can “use the existing objects.” In actuality, the objects are deleted 
and re-created, so if you have customized the properties of the existing objects, you must customize 
the objects again after installing WebAccess on Linux. 

9.3.6  --httpport Switch Not Listed in webac70a.waa File

The -httpport switch has been added to the Linux WebAccess Agent to specify the port number for 
HTTP communication. However, it is currently not listed in the webac70a.waa file on Linux.

9.3.7  Viewer Agent Issues on Linux

On Linux, if you run the Viewer Agent as a user that is not running The X Window system, 
then WebAccess client users cannot view embedded vector-based graphics in attachments. To 
enable users to view embedded vector-based graphics, make sure that the user that starts 
WebAccess (and hence, the Viewer Agent) is running The X Window System and has a 
DISPLAY environment variable set so that the Viewer Agent can write to the local display. One 
way to accomplish this is to use the sux command to become root before you start the 
WebAccess Agent.
On Linux, the third-party viewer software used by the Viewer Agent has a dependency on 
libXm.so.1, which might not be included with your Linux package. To resolve this, create a 
symbolic link in the agents lib directory to the version of the libXm modules that is available 
on your Linux server. For example:
ln -s /usr/X11R6/lib/libXm.so.3.0.1 /opt/novell/groupwise/
                                               agents/lib/libXm.so.1

9.3.8  WebPublisher Configuration

The WebAccess Installation program does not configure WebPublisher for you. Some manual 
configuration is required. For instructions, see the GroupWise 7 Installation Guide (/docs/us/
GroupWiseInstallationGuide.pdf).

9.3.9  Commented Lines in Configuration Files

If you have commented out any lines in the Linux WebAccess configuration file (webacc.cfg) or 
the WebPublisher configuration file (webpub.cfg), you should back up those files before 
installing GroupWise 7. If you use the Configure WebAccess Application option in the Installation 
program, those commented lines become uncommented and the settings return to their defaults. 
However, any other changes you have made to the configuration files are retained. You must 
comment out the lines again and edit the settings as needed, using the backup copies for reference.

9.3.10  WebAccess Client Help Displays Incorrectly in Firefox on Linux

In Firefox on Linux, the horizontal scroll bar in the left panel of the WebAccess client help displays 
in the middle of the column instead of at the bottom. It does not interfere with help functionality.
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10  Internet Agent Issues
Section 10.1, “General Internet Agent Issues,” on page 35
Section 10.2, “NetWare/Windows Internet Agent Issues,” on page 35
Section 10.3, “Linux Internet Agent Issues,” on page 35

10.1  General Internet Agent Issues
“/copyonly Startup Switch Doesn’t Update the Database Version” on page 35
“Address Resolution Change Since GroupWise 6” on page 35

10.1.1  /copyonly Startup Switch Doesn’t Update the Database Version

If you use the /copyonly startup switch on the Internet Agent Installation program to install 
GroupWise 7 Internet Agent software from a Support Pack to update original GroupWise 7 
software, the database version on the GWIA object is not updated. As a result, the Support Pack 1 
enhancement described in “Consolidated Configuration Information” in “What’s New in GroupWise 
7” in the GroupWise 7 Installation Guide (http://www.novell.com/documentation/gw7) does not 
occur. Therefore, you should not use the /copyonly startup switch when updating an existing Internet 
Agent installation to a GroupWise 7 Support Pack.

10.1.2  Address Resolution Change Since GroupWise 6

In GroupWise 6 and its Support Packs, there was a problem with the address format used for sending 
to distribution lists and resources if you set Internet Addressing to one of the following formats 
(which are not appropriate for distribution lists and resources):

first_name.last_name@Internet_domain
last_name.first_name@Internet_domain

Messages to distribution lists and resources were initially undeliverable and were sent to the Internet 
Agent. The Internet Agent then successfully resolved the addresses and sent the messages back into 
the GroupWise system. Users did not notice the problem, but some administrators noticed 
unnecessary traffic through the Internet Agent.

In GroupWise 6.5, the address format problem for sending to distribution lists and resources was 
corrected. However, users who originally used GroupWise 6 have the erroneous address format for 
distribution lists and resources in their Frequent Contacts address books. If you are updating from 
GroupWise 6 to GroupWise 7 and unnecessary traffic through the Internet Agent is a continuing 
problem, have users delete distribution lists and resources from their Frequent Contacts address 
books so that the correct address format is used for name completion in the future.

10.2  NetWare/Windows Internet Agent Issues
None.

10.3  Linux Internet Agent Issues
“Obsolete grpwise-ia Script” on page 36
“Installation Security” on page 36
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“libXm.so.3 Error” on page 36

10.3.1  Obsolete grpwise-ia Script

GroupWise 6.5 included the /etc/init.d/grpwise-ia script for starting and stopping the 
Linux Internet Agent. In GroupWise 7, the Internet Agent is started along with the POA and the 
MTA, using the grpwise script. Therefore, you should delete the obsolete grpwise-ia script 
from /etc/init.d so that it is not used inadvertently.

10.3.2  Installation Security

During installation, the Linux Internet Agent Installation program requires access to eDirectory by 
way of LDAP authentication. The LDAP Group object includes an option named Require TLS for 
Simple Binds with Password, which is enabled by default. With this option enabled, you must 
provide the LDAP server’s trusted root certificate, which must be exported from the LDAP server, 
in order for LDAP authentication to take place (typically on port 636) during installation of the 
Internet Agent.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple Binds 
with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear text 
(typically on port 389), during installation of the Internet Agent. After disabling the option, restart 
eDirectory, install the Internet Agent, then re-enable Require TLS for Simple Binds with Password 
and restart eDirectory again.

10.3.3  libXm.so.3 Error

If you try to start the Linux Internet Agent using the --show switch on a server where The X Window 
System and Open Motif are not running, you receive the following error:
libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the Internet Agent 
with the --show switch. If you start the Internet Agent without the --show switch, you can use the 
Internet Agent Web console to monitor the Internet Agent from your Web browser.

11  Monitor Issues
Section 11.1, “General Monitor Issues,” on page 36
Section 11.2, “Windows Monitor Issues,” on page 37
Section 11.3, “Linux Monitor Issues,” on page 38

11.1  General Monitor Issues
“Problem Starting GroupWise Monitor” on page 37
“Restoring Monitor Settings after Reinstallation” on page 37
“Monitor Agent SSL Configuration” on page 37
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11.1.1  Problem Starting GroupWise Monitor

If the location of the Monitor template files is inadvertently changed, then you cannot start 
GroupWise Monitor. To resolve the problem:

1 Locate the gwmonitor.cfg file.

The location of the Monitor configuration file varies by platform:

2 Locate the Templates.Path line and correct the path as needed.
The location of the template files varies by Web server platform:

3 In ConsoleOne, browse to and right-click the GroupWiseMonitor object, then click Properties.
4 Click Application > Templates.
5 In the Template Path field, correct the path as needed, then click OK. 

When the correct template path has been supplied in the gwmonitor.cfg file and on the 
GroupWiseMonitor object in ConsoleOne, you should be able to start GroupWise Monitor.

11.1.2  Restoring Monitor Settings after Reinstallation

Monitor settings are stored in the monitor.xml file in the Monitor installation directory. Agent 
groups are also stored in this file. If you reinstall the Monitor software, the monitor.xml file is 
backed up as monitor.001. To restore previous Monitor settings and agent groups, remove the 
newly installed monitor.xml file and rename monitor.001 to monitor.xml.

11.1.3  Monitor Agent SSL Configuration

If you want to enable SSL by using the Monitor Agent /httpssl and /httpcertfile switches, the 
certificate file must be in PEM format. This differs from the other GroupWise agents, which take a 
.b64 public certificate file and a .key private key file. The PEM format combines the certificate 
and key in a single file.

11.2  Windows Monitor Issues
“New NetWare and Windows Monitor URLs” on page 37

11.2.1  New NetWare and Windows Monitor URLs

If you’ve used Monitor on a NetWare or Windows Web server, you are accustomed to accessing the 
following URLs:

Linux: /opt/novell/groupwise/monitor

Windows: \novell\gwmonitor

Apache on 
Linux:

/var/opt/novell/gwmon/WEB-INF/classes/com/novell/
                                    gwmonitor/templates

Apache on 
NetWare:

\tomcat\4\webapps\gw\WEB-INF\classes\com\novell\
                                    GWMonitor\templates
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Starting in GroupWise 7, use the following URLs on NetWare and Windows Web servers:

To keep users’ browser bookmarks from being broken, you should redirect the old URLs to the new 
URLs. Follow the instructions in Section 9.2.6, “New NetWare and Windows WebAccess URLs,” 
on page 29, substituting /gw/gwmonitor for /gw/webacc as needed in the instructions.

11.3  Linux Monitor Issues
“Linux Update Error” on page 38
“Monitor Issues Shared with WebAccess” on page 38

11.3.1  Linux Update Error

If you have installed interim releases of Monitor between Support Pack 1 and Support Pack 2, and if 
you are installing Monitor on a server where other GroupWise agents are also running, you might 
receive the following error message:
Install failed for an unknown reason (8)

To work around this error message:

1 In a terminal window, uninstall the Monitor Application by using the following command:
rpm -ev --justdb novell-groupwise-monitor

This command removes the Monitor Application from the RPM database so that it does not 
interfere with the installation of the other GroupWise components on the server.

2 In the GroupWise Installation program, update the other GroupWise components on the server.
3 Reinstall the Monitor Application individually, and do not select the Configure option in the 

GroupWise Installation program.

11.3.2  Monitor Issues Shared with WebAccess

Monitor and WebAccess share a substantial amount of functionality. The following WebAccess 
issues also pertain to Monitor:

Section 9.3.1, “WebAccess on SUSE Linux Enterprise Server 10,” on page 32
Section 9.3.2, “Novell Distribution of Apache and Tomcat,” on page 32
Section 9.3.3, “Prolonged “Please Wait” Message during Installation,” on page 33
Section 9.3.4, “Installation Security,” on page 33
Section 9.3.5, “Re-installation Issue,” on page 34

Web Services page: Default index.html file of Web server

Monitor Web Console: http://web_server_address/servlet/gwmonitor

GroupWise-specific Web 
Services page:

http://web_server_address/gw/index.html

Monitor Web Console: http://web_server_address/gw/gwmonitor
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12  International Issues
Section 12.1, “General International Issues,” on page 39
Section 12.2, “NetWare/Windows International Issues,” on page 41
Section 12.3, “Linux International Issues,” on page 41

12.1  General International Issues
“Default MIME Encoding Change” on page 39
“Double-Byte Characters in Directory Names and Filenames” on page 40
“Double-Byte Characters in Passwords” on page 40
“Character Encoding in WebAccess” on page 40
“WebAccess Spell Checker Displays Corrupt Characters for Russian” on page 40
“WebAccess Attachments with Extended Characters in the Filenames” on page 40

12.1.1  Default MIME Encoding Change

After GroupWise 7 Support Pack 1, the GroupWise client started using UTF-8 instead of ISO for 
MIME encoding. This causes occasional problems in some languages where GroupWise 6.5 clients 
are being run against GroupWise 7 post offices. To help with the transition, a Support option has 
been added to GroupWise Check (GWCheck) to convert user databases back to the ISO encoding 
for your language.

1 Start GWCheck as described in GroupWise Check in Databases in the GroupWise 7 
Administration Guide (http://www.novell.com/documentation/gw7).

2 Under Database Type, select Post Office.
3 In the Database Path field, browse to and select the post office directory.
4 Under Object Type, select User/Resource.

If you want to perform the conversion on all user and resource databases in the post office, 
specify ALL in the User/Resource field.

5 In the Action drop-down list, select Reset Client Options.
6 In the Support Options field on the Misc tab, type setmimeencoding=number, where 

number is one of the following character set numbers:

Character 
Set Number Language

1 Windows default

2 ISO default

7 Arabic (Windows 1256)

9 Baltic (Windows 1257)

12 Central European (Windows 1250)

13 Chinese Simplified (GB2312)

15 Chinese Traditional (Big5)
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7 Click Run to perform the conversion of user and resource databases from UTF-8 to the selected 
character set.

12.1.2  Double-Byte Characters in Directory Names and Filenames

Do not use double-byte characters in directory names and filenames.

12.1.3  Double-Byte Characters in Passwords

Do not use double-byte characters in user passwords. 

The Change GroupWise Password dialog box in ConsoleOne currently allows entry of double-byte 
characters. However, the GroupWise client login does not allow entry of double-byte characters in 
passwords, so a user who was assigned a password with double-byte characters in ConsoleOne 
cannot type the double-byte characters when attempting to log in to GroupWise.

12.1.4  Character Encoding in WebAccess

Auto-detection of character encoding for the WebAccess/WebPublisher index.html page does 
not work for some Web browsers. If you do not see the localized languages in the drop-down menu 
on the Web services page (index.html), set your Web browser’s character encoding to UTF-8. In 
some browsers, you can click View > Encoding to set the Web browser’s encoding.

You might also encounter character encoding problems when reading HTML-formatted messages. 
In this case, set your Web browser’s character encoding for the new message window to UTF-8. You 
can do this by right-clicking in the new message window and then setting the encoding, or by 
clicking View > Encoding.

12.1.5  WebAccess Spell Checker Displays Corrupt Characters for Russian

When Russian characters are used, they are displayed in the Spell Checker as corrupt characters.

12.1.6  WebAccess Attachments with Extended Characters in the Filenames

On Windows, Mozilla*-based browsers such as Firefox and Netscape* do not save extended 
character filenames correctly, even though the filename displays correctly in the Save As dialog box. 
This is a browser problem, not a GroupWise problem. There is no workaround.

18 Cyrillic (K018-R)

27 Hebrew (Windows 1255)

29 Japanese (ISO2022-JP)

30 Japanese (Shift-JIS)

32 Korean (EUC-KR)

33 Thai (Windows 874)

35 Turkish (Windows 1254)

3 UTF-8

Character 
Set Number Language
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In Safari* on Macintosh, extended character filenames are not interpreted correctly. As a 
workaround, use Firefox instead of Safari if you receive attachments with extended character 
filenames. This is a browser problem, not a GroupWise problem. 

12.2  NetWare/Windows International Issues
“Print Calendar Language” on page 41
“Japanese Viewers for WebAccess” on page 41

12.2.1  Print Calendar Language

The GroupWise client Print Calendar feature always prints calendars in the language specified in 
Regional Options or Regional Settings in the Control Panel, even if the client is installed in a 
different language. For example, if French (Switzerland) or French (Swiss) is specified in the 
Control Panel and the client is installed in German, calendars print in French.

12.2.2  Japanese Viewers for WebAccess

In the WebAccess client running on Japanese Windows XP, some characters might not display 
correctly.

12.3  Linux International Issues
“Display Problem with Agent Console Interfaces” on page 41
“Russian Keyboard” on page 41
“Mnemonics for Arabic, Hebrew, and Double-Byte Languages” on page 42
“Localized Agent User Interface Display” on page 42

12.3.1  Display Problem with Agent Console Interfaces

If you run the Linux GroupWise agents with an agent console interface in languages other than 
English, logging information might not display correctly. The problem occurs if your language 
encoding is set to UTF-8.

To determine your current language encoding, use the following command in a terminal window:

locale

You can change your language encoding in YaST:

1 Start YaST, click System, then double-click Choose Language.
2 Select the language you are running the agents in, then click Details.
3 Deselect Use UTF-8 Encoding, then click OK.
4 Stop and then restart the agents to put the new setting into effect.

12.3.2  Russian Keyboard

When you use a Russian keyboard, the Linux environment variables that provide language and 
locale information are typically set to ru_RU. Typically, this setting implies the Russian character 
set ISO-8859-5. However, on some distributions of Linux, the ISO-8859-5 character set must be set 
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explicitly in order for your Russian keyboard to work with the GroupWise Cross-Platform client. 
Use the following command to specify the character set along with the language and locale 
information:

export LANG=ru_RU.ISO-8859-5

In most cases, setting the LANG environment variable also sets all LC_* environment variables and 
resolves all Russian keyboard problems. If you set the LANG environment variable and your 
Russian keyboard still does not work, use the following command to view the current settings for 
the LANG and LC_* environment variables:

locale

If any of the LC_* environment variables have not inherited the ISO-8859-5 specification, export 
them individually.

12.3.3  Mnemonics for Arabic, Hebrew, and Double-Byte Languages

Keyboard mnemonics for menu items work for characters a-z and A-Z, but not for other characters.

12.3.4  Localized Agent User Interface Display

The Linux GroupWise agent user interfaces display correctly if the Linux environment is using the 
ISO-8859-1 character set, which is the default for the GroupWise administration languages and 
locales.

French: fr_FR
German: de_DE
Portuguese: pt_BR
Spanish: es_ES

If the Linux environment is using a different character set encoding such as UTF-8 (for example, 
fr_FR.UTF-8), the localized agent user interfaces do not display correctly.

13  Documentation Issues
Section 13.1, “General Documentation Issues,” on page 42
Section 13.2, “NetWare/Windows Documentation Issues,” on page 42
Section 13.3, “Linux Documentation Issues,” on page 43

13.1  General Documentation Issues
None.

13.2  NetWare/Windows Documentation Issues
“GroupWise Windows Client Help” on page 43
“WebAccess/WebPublisher Help on a UNIX Web Server” on page 43
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13.2.1  GroupWise Windows Client Help

To support accessibility requirements within GroupWise Help, the Help for the GroupWise 
Windows client uses Microsoft HTML Help. In order for Microsoft HTML Help to display on a 
Windows workstation, the workstation must have Internet Explorer 4.x or later installed.

13.2.2  WebAccess/WebPublisher Help on a UNIX Web Server

If you install the WebAccess Application and the WebPublisher Application on a UNIX* Web 
server, as described in “Completing the Installation on a UNIX Apache Web Server in Installing 
GroupWise WebAccess” in the GroupWise 7 Installation Guide (http://www.novell.com/
documentation/gw7), you now need to install the WebAccess and WebPublisher help files manually.

After installing the WebAccess Application and the WebPublisher Application:

1 Change to the gw/com/novell/webaccess directory of the Web server.
2 Unzip the  __help__.zip file.
3 Change to the gw/com/novell/webpublisher directory of the Web server.
4 Unzip the  __help__.zip file.

Online help is now available for WebAccess and WebPublisher users.

13.3  Linux Documentation Issues
“Agent Help Does Not Display When GroupWise Agents Run as a Non-root User” on page 43
“Help Image Display on an iChain Server” on page 43

13.3.1  Agent Help Does Not Display When GroupWise Agents Run as a Non-root 
User

When you start the Linux POA, the Linux MTA, and the Linux Internet Agent using the --show 
switch to display a GUI user interface, if the agents are running as a non-root user, clicking Help 
does not display the agent help file. Help is displayed in a browser window and the agents currently 
launch the browser as root. Giving the user access to the browser window as root would be a 
security risk. This is working as designed.

13.3.2  Help Image Display on an iChain Server

If you display help from an agent Web console on a server where Novell iChain® is installed, and if 
iChain is configured to use the Path-Based Multihoming option, the image at the top of the help 
topic does not display.

14  GroupWise Bug Fixes
Section 14.1, “Address Book Fixes,” on page 44
Section 14.2, “Administration Fixes,” on page 44
Section 14.3, “Admin API Fixes,” on page 45
Section 14.4, “Agent Fixes,” on page 46
Section 14.5, “Client Fixes (Windows),” on page 46
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Section 14.6, “Client Fixes (Cross-Platform),” on page 51
Section 14.7, “Client Fixes (Outlook Connector),” on page 51
Section 14.8, “Client API Fixes,” on page 51
Section 14.9, “Engine Fixes,” on page 53
Section 14.10, “GWCheck Fixes,” on page 54
Section 14.11, “Internet Agent Fixes,” on page 54
Section 14.12, “Monitor Fixes,” on page 56
Section 14.13, “WebAccess Fixes,” on page 56

14.1  Address Book Fixes
When you create a new contact, it is time-stamped with the correct time format.
Changes made to shared address books always replicate accurately to users with whom the 
address books are shared.
In Caching mode, personal address books always display synchronized with personal address 
books in Online mode. 
If you share an address book and if a user in the shared address book is later deleted from the 
GroupWise system, replication of subsequent changes to the shared address book is successful 
for the post office from which the user was deleted.
The Address Book handles the situation where you try to create a user defined field but leave 
the field name blank.
When printing labels from an address book, all selected labels are included in the printout.
You can import an address book that includes more than 5000 contacts.
The Address Selector positions correctly to names starting with “Z”.
If you use a .nab file to import a group that already exists in an address book, the client 
prompts you about whether to overwrite the existing group.
Swedish sorts correctly in the GroupWise Address Book.
On Windows 2000 Professional Chinese Edition, groups are correctly created without 
duplicating users.

14.2  Administration Fixes
If ConsoleOne creates an object in one eDirectory replica and then tries to read it from an 
eDirectory replica where the new object has not replicated yet, ConsoleOne waits for 
replication to take place rather than returning an error.
When you specify a remote location in a cluster, you can use an IP address instead of a server 
name in a UNC path.
Moving a user never affects the user’s password.
You can move a resource from one post office to another when you are not connected to the 
domain that owns the post offices.
HTML-formatted global signatures display with correct line spacing.
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If you deselect HTML in the Allowable Read Views and Allowable Compose Views boxes on the 
Views tab of Client Options, and then lock the settings, client users are prevented from selecting 
HTML in the comparable boxes in the GroupWise client.
If Allow Purge of Items Not Backed Up is deselected on the Cleanup tab of Client Options, it 
does not affect the overwriting of messages in the Work in Progress folder in the GroupWise 
client.
If Enable Single Sign-On is deselected on the Password tab of Security Options in Client 
Options, the Use Single Sign-On field does not display in the GroupWise client login dialog 
box.
When a distribution list is replicated to an external system, the membership and member 
participation are replicated completely and accurately.
When you change the restore area for a post office, the change is replicated throughout your 
GroupWise system.
On the Rights property page of a Library object, when you select Manage (Librarian), all rights 
are automatically selected and dimmed.
When you select Restrict System Operations to Primary Domain on the Admin Lockout tab 
under Tools > GroupWise System Operations > System Preferences, the list of system 
operations that is available to administrators who are connected to secondary domains displays 
the correct list of operations.
Multiple link configuration changes no longer cause the MTA IP address to be lost.
ConsoleOne with the GroupWise Administrator snap-in can connect to a domain if you specify 
the wpdomain.dc filename along with the domain directory path.
TSAFSGW no longer backs up GroupWise queue directories in order to avoid generating 
spurious backup error messages on the transient files that are found in these directories.
The Linux GroupWise Database Copy utility (DBCopy) checks for uppercase and lowercase 
database names before completing the copy operation.
The GroupWise Identity Manager driver removes and added users to distribution lists in the 
proper order.
You can now set the default MIME encoding for messages in ConsoleOne. Select a Domain, 
Post Office, or User object, then click Tools > GroupWise Utilities > Client Options > Send. 
On the Send Options tab, select the desired MIME encoding.

14.3  Admin API Fixes
The information displayed in the LDAP Authentication field on the GroupWise Account 
property page of User objects in ConsoleOne is now available to the GroupWise Admin API.
When creating an External Entity object, the Admin API uses the specified File ID rather than 
generating a new one. 
The DefaultSecurityLevel property returns addition security levels.
If an account does not have an expiration date set, the Admin API returns absence of the date 
correctly.
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14.4  Agent Fixes
On Open Enterprise Server 2, when installed on NSS volumes and configured for automatic 
startup, the GroupWise agents start after NSS.
For the Linux agents, you can determine the build date of the agent that produced a core file by 
checking the process_id.pid file that is left in the agent’s log file directory when the 
agent does not shut down normally.
When the POA tries to index a damaged message and fails, it still indexes the fields (From, 
Subject, and so on) associated with the damaged message.
When a message is blocked by a sender, the POA log file lists the blocked recipient.
The POA can successfully change a password for a user in Active Directory*.
The POA can successfully deliver messages when the post office name includes angle brackets 
(<>).
The Linux POA can more accurately calculate the percentage of available disk space.
When attempting to access a restore area, the POA takes the path provided in the Linux Path 
field in ConsoleOne, rather than then UNC Path field.
If a message contains an invalid Chinese character, the character is replaced with a question 
mark (?) so that the whole message is not discarded as invalid.
Fixed some POA abends.
The new /vsnostatus startup switch prevents GroupWise status messages from being routed to 
third-party virus/spam scanning applications. Because GroupWise status messages are created 
within GroupWise, it is not likely that they contain viruses or spam. This switch speeds up 
routing of status messages through the MTA.
The Linux MTA now creates its PID file before changing to run as a non-root user.
Fixed some MTA abends.
When the Linux agents are configured to start automatically on system startup and they are 
configured to start in a language other than English, they start successfully in the language 
specified by the /language startup switch. 
The OCF Resource Agent script (GroupWise) that is included in the GroupWise High 
Availability service (gwha) RPM has been enhanced to work better with the Messenger agents. 

14.5  Client Fixes (Windows)
The GroupWise client can be installed by ZENworks® 7 on top of an existing installation that 
was performed by the Administrator user.
MailTo links in Web pages can successfully start GroupWise.
If Novell Single Sign-On is not installed, the Use Single Sign-On field does not display in the 
GroupWise client login dialog box.
The GroupWise main window can be brought to the foreground on top of a View Message 
window.
The GroupWise client fills in the Reply To field correctly when the To and CC fields both 
contain the same username.
If you forward an HTML-formatted message that was originally created in a program other 
than GroupWise, the original HTML formatting is not changed when the message is forwarded.
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When you spell check an HTML-formatted message, duplicate words can be replaced with a 
single instance.
The GroupWise Windows client no longer uses Base64 encoding for items saved in the Work in 
Progress folder. Plain text messages are saved as plain text. HTML-formatted messages are 
saved as HTML.
If you save an HTML-formatted message in the Work in Progress folder when your default 
Compose view is set to Plain Text, the HTML formatting is still retained in the saved message, 
and the message opens again in HTML Compose view.
When a message is replied to and forwarded to multiple users, the each sender’s default font 
and point size is always retained.
If you view a plain text message and then change the displayed font size by using Print 
(Preview) Options > Change Font, the message displays and prints in the selected font.
The reply to an encrypted plain text message includes the sender’s message when the sender 
selects that option.
A rule-delegated plain text message displays correctly when the recipient replies to it in HTML 
compose view.
If you are composing a plain text message that has attachments and you print it, you have the 
option of printing the attachments along with the message.
When you view a plain text posted appointment, note, or task, you can change from Plain Text 
view to HTML view without losing the text of the posted item.
When you copy and paste an image or table from another source into a GroupWise message, it 
is no longer stored as a bitmap. This results in smaller message sizes for GroupWise messages 
that contain such elements.
If you paste a URL that contains %xx sequences into a message and send it, the sequences are 
no longer interpreted as Unicode* characters and the URL displays properly when the message 
is received.
The Internet standard reply format works for digitally signed messages.
If you create a new message and attach a file, you can right-click the attached file and use Save 
As to save the attachment.
When you open a message that has attachments, the attachments never generate a D107 error.
If you attach a file that is deleted from the file system before you send the message, you are 
warned that the attachment file is missing.
When you save an attached document reference, it is saved with the filename you specify.
If you attach a file that resides in a directory with a very long pathname, the file size is still 
calculated correctly.
You can multiple-select items in a filtered list and then successfully delete the selected items.
If you change the sort order of a list of messages, then use the Display drop-down list to change 
the display settings (for example, from Received Items to Sent Items and back again), the sort 
order remains constant.
Items where Conceal Subject has been selected on the Send Options tab display without subject 
lines in the Month view of the Calendar.
If you specify a resource that is not a place in the CC field of an appointment, it does not 
overwrite what you specify in the Place field.
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Recurring appointments that are deleted from the Month view of the Calendar are retracted 
from recipients’ mailboxes.
When you drag and drop an appointment to a different day of the month in the Month view of 
the Calendar that is displayed by clicking Window > Calendar > Month, it displays correctly 
when viewed in the main Calendar view.
If you use a rule to accept and decline appointments, the rule does not decline appointments 
that fall on a day that has an all-day event already scheduled. All-day events are considered 
“free.”
When the Month view of the Calendar is displayed in a panel of the Home view, appointments 
are not duplicated.
With your Calendar displayed as a Checklist, you can create more than 20 recurring posted 
appointments.
Comments accompanying a Meeting Canceled message display correctly.
If you reply to a Meeting Canceled message, the reply displays correctly.
If you decline an appointment but don’t delete it, and then select Show as Free, the appointment 
displays in white on your Calendar.
Appointments imported from .ics files in the Sydney, Australia, time zone display the correct 
times when daylight saving time is in effect.
The Windows client sends correct time zone codes for all time zones.
In the Multi-User Calendar view, the Add or Remove Users option always works.
If you change the order of users in the Multi-User Calendar list, it does not affect the original 
proxy list.
If you create a task with a specific priority, then edit other settings of the task, the priority 
setting is not affected.
A task created without a due date always displays without a due date and never becomes 
overdue.
Categories can be applied to all instances of a recurring Calendar item.
User-created categories are retained on posted appointments.
You cannot save a message again in the Work in Progress folder until the initial save has been 
completed. If the message includes large attachments, you might need to wait before the second 
save can be performed.
If you try to save a message with an invalid address in the Work in Progress folder, a message 
informs you that there is an error.
From a shared folder, you can forward items as attachments when you are not the owner of the 
shared folder (assuming you have the rights required for this operation).
If a user receives a message that is also placed in a shared folder, and if that user deletes his or 
her personal copy of that message, it does not affect the copy in the shared folder.
The contents of a large Find Results folder can be saved successfully.
When you move an item to the archive from a Find Results window, the archived item 
disappears from the Find Results window.
The GroupWise client returns the appropriate error if it attempts to archive to a location where 
no free disk space is available.
Messages with asterisks (*) in the subject line print correctly.
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When printing a message, the message header and the message body print in the same size font.
When printing a plain text message, the Bigger and Biggest selections in the Message Font Size 
drop-down list print in different sizes.
Messages printed from the QuickViewer include headers.
Notes are printed on calendars imported from .ics files.
Large attachments print directly from GroupWise, without needing to open the application that 
created them.
Creating a new, empty archive no longer affects the display settings of the Home panel.
Damaged sent items that have been archived can be repaired and unarchived.
In Remote mode, setting Minimum Client Release options does not prevent the downloading of 
attachments when the appropriate version/date criteria are met.
If you proxy into another user and send a message where you have changed the name in the 
From field from the proxy user to a different user, the recipient sees the sender as the user you 
specified, followed by the proxy user in parentheses.
Proxying into another user’s mailbox does not affect the original user’s list of signatures.
When you are proxied into a resource mailbox, the default signature is correctly appended.
When you proxy into another user that is configured to add a signature automatically and send 
a message, the user’s signature is added to the message.
Viewing the properties of messages when you are proxied into another user’s mailbox does not 
affect the view files installed on your workstation.
When you edit an existing rule that sends a message, the existing contents of the To field 
display correctly.
If a user blocks a sender using the Junk Mail Handling feature, the GroupWise client no longer 
replies to subsequent messages from the blocked user.
You can use Save As to save a document in the Documents folder under another name.
The GroupWise client is consistently able to open PDF files stored in libraries.
If you close a checked-out library document by using the Close button (X in the upper left 
corner of the window) in Word, the document is successfully closed and checked back into the 
library. 
You can use the Close button (X in the upper left corner of the window) in Excel*. The 
spreadsheet is successfully closed and checked back into the library.
Word 2007 documents can be checked back into GroupWise libraries.
With integrations turned on, you can view and open documents created by Windows Office 
2003 and Windows Office 2007.
Integrations can be turned on and off for Microsoft Excel and spreadsheets to display properly.
The Custom Views feature works properly again.
From the Notify window, if you read a message that has been moved to a folder by a rule and 
then delete the message, the client can determine what folder the message has been moved to 
and successfully delete it.
If you conceal the subject of a message in the Windows client, it is concealed when you view 
the message in the Cross-Platform client.
The Tools > Dial Sender options works again.
GroupWise 7 Support Pack 3 49



50 GroupWise 

novdocx (en)  11 D
ecem

ber 2007
MIME encoding can be consistently set using Tools > Options > Send, then selecting from the 
MIME Encoding drop-down list.
When the Windows client is inactive, it suppresses the message that the connection to the post 
office has been lost. The same change applies to Notify.
The /c startup switch works correctly.
The Windows client makes sure that the \temp\xpgrpwise directory exists before 
attempting to render HTML-formatted messages.
Messages received through the GroupWise API gateway display the username correctly on the 
message properties page.
You can set GroupWise as the default MailTo client on Windows Vista* by using Start > 
Control Panel > Programs > Default Programs > Set Program Access and Computer Defaults 
> Custom.
On Vista, when you drag and drop GroupWise items to the desktop, they display with their 
respective GroupWise icons and the items on the desktop behave appropriately.
The GroupWise client can successfully connect to a Unity IMAP server.
Simple MAPI calls from other programs still work after GroupWise has been installed.
The GroupWise viewer displays images in Word documents if you change the viewer mode 
from Draft to Normal. You only need to make the change once, not on each document viewed.
If you run the Windows client from a terminal server and open a library document with 
Microsoft Word, the document opens correctly.
If you create a Word document from GroupWise and send it as an attachment without saving it 
first, it arrives successfully.
You can open multiple Word documents at the same time from GroupWise.
You can overwrite existing Excel spreadsheets from GroupWise.
You can send PowerPoint* 2007 presentations in PDF format as message attachments from the 
GroupWise client.
Unicode is enabled when opening attachments.
With the Windows operating system set to English and the GroupWise language set to a locale 
where the GroupWise .dll and .fil filenames included extended characters, the Calendar 
folder now displays correctly.
If you change a message that uses a specific language character set to another item type such as 
a posted appointment or task, the language character set is retained in the new item type.
Appointments with extended characters in the Subject line can be successfully delegated by a 
rule.
The Euro character (€) displays correctly in a plain text message that uses ISO-default 
encoding.
Chinese characters in the To and Subject fields of messages sent from external e-mail systems 
are displayable in GroupWise.
Attachments with filenames that include Chinese simplified characters are saved with correct 
filenames.
During spell checking, Chinese characters are no longer underlined in red as if they are 
misspelled.
Chinese characters can be input easily in the signature editor.
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Incorrect MIME encoding for a few Chinese characters has been corrected.
The Chinese client can forward attachments whose filenames are in Japanese characters.
In the Japanese client, the Duration field of a new appointment can be changed from 1 hour.
In the Japanese client, if you print a message while you are still composing it, the Japanese 
characters print correctly.
The subject line of a Japanese appointment is not collapsed when the appointment is delegated.
Japanese characters are found consistently in searches.
In Remote mode, the subject line in the Pending Requests to Online Mailbox dialog box is not 
collapsed.
When printing a Japanese message, the recipient’s name and the subject line are printed in full.
The Scandinavian clients use ISO-8859-15 as the default for MIME encoding.
Fixed several client crashes.

14.6  Client Fixes (Cross-Platform)
In an open message, you can right-click any user in the To field to display user information.
If you conceal the subject of a message in the Windows client, it is concealed when you view 
the message in the Cross-Platform client.
The Cross-Platform client can handle attachment names that include an extra slash (/). 
Attached OpenOffice documents display the OpenOffice icon in the Attachments window.
All Day Events are included in Busy Search results.
Add Day Events lasting longer than 24 days can be created.
The Cross-Platform client on Linux performs acceptably even when another process is causing 
a high CPU utilization state on the workstation.
The Cross-Platform client on Linux synchronizes reliably with the POA in Caching mode.
In Caching mode, the Cross-Platform client on Macintosh can send large attachments without 
its TCP/IP connection timing out.
The Cross-Platform client on Macintosh starts successfully on Mac OS 10.3.9.
On the GNOME* desktop, the MailTo command starts GroupWise correctly.
Fixed some client crashes.

14.7  Client Fixes (Outlook Connector)
Categories interoperate between GroupWise and Outlook.

14.8  Client API Fixes
The new EventNoticeRegisterEx token passes the permanent message ID back to a third-party 
function.
The new RetrieveMime token provides parameters to import EML files into the Send Items 
folder, the Mailbox folder, or the Work in Progress folder.
The ItemMessageSave token now includes parameters to save messages in RTF and MIME 
formats.
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The ItemSaveMessageDraft token works correctly when the folder path parameter is used with 
it.
A new parameter has been added to the ItemMessageIDFromView token so that an attached 
message can be viewed rather than opened.
The FolderSelectDlg token works in the Panels view.
The PrefAdvanced token and the FocusSet token still work if the user views the Send Options 
tab while composing a message.
The ItemMessageIDFromView token has a new parameter that returns the message ID of an 
attached message that is viewed rather than opened. 
The ItemSetText token successfully appends addresses to the contents of the To, CC, and BC 
fields.
The ItemAttachmentAdd token works when adding document references.
The modifyProxyAccessRequest method can revoke access rights as well as set them.
The modifyProxyAccessRequest method can create the <All User Access> right.
The getSettingsRequest method returns the MIME encoding setting.
The createItemRequest method no longer returns the sender in the recipient list.
The replyTo element works correctly when sending messages from GroupWise out over the 
Internet.
The Query object can search archives.
The Message.Hidden property for document references is correctly set to false.
The AddExistingMessage function can successfully add text that includes tab characters.
The Find filter works with custom message subtypes.
The Folder.Messages.Find function correctly filters messages in the folder.
Folder.FindMessages and Message.Find return more than 4 KB of items.
The TrashEntries collection returns 65535 when the Trash folder contains more than 64 KB of 
items, rather than returning 0.
The AddressBookRights collection can be modified and deleted.
The GroupWise Address Book Control works when accessing organizations.
The AddressBookRightsCollection.Add method works correctly.
In Address Book entries, visibility can be set to Unknown.
MAPISendMail works correctly even when the address type information is missing.
MAPISendMail sends attachments properly even when users are not allowed to edit the 
message.
Custom fields added by the Client API display correctly in the GroupWise client.
The Client API can retrieve an image into a draft message when the path to the image includes 
a space.
The Client API checks for private messages by using the same method as the GroupWise client 
uses.
The Client API can export FIDs on Address Book entries.
The IGWTask2 and IGWTask3 GUIDs work correctly again.
Compatibility with RIM’s Blackberry* Enterprise Server has been improved.
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Deleting a folder no longer causes a memory leak.
A C3POTM can now delete a GroupWise menu that has submenus.
A C3PO can use OnCloseItem to determine which item is being closed.
The contents of the Subject and Place fields translate correctly from Unicode.
The Attachment.Save method successfully saves attachments with filenames that include 
Chinese and other double-byte characters.

14.9  Engine Fixes
Fixed an IMAP abend.
iCal handles appointments with attachments that are addressed to external users.
When a calendar is exported into an iCal file, the resulting .ics file includes the message 
body text of appointments.
If an iCal appointment is deleted after it has taken place, iCal does not send a Declined message 
to the sender.
When you send an iCal appointment that leaves the GroupWise system and gets delivered back 
to internal recipients (for example, through a list server), proper status information is returned 
to the sender.
The VALARM section of the .ics file is processed correctly.
iCal can process a VTimeZone option that does not have a time zone ID string.
The iCal time zone definition iCal for the Eastern Time (US & Canada) time zone has been 
corrected.
The iCal time zone definition for New Zealand now defines daylight saving time.
iCal handles appointments where the Place field includes extended characters.
SOAP performance has been improved by using HTTP GET instead of getAttachmentRequest 
to stream attachments more efficiently.
SOAP can now filter on categories.
SOAP can look up external GroupWise users.
SOAP can handle exception dates on a set of recurring items.
SOAP includes the original time zone information when creating calendar items to facilitate 
future time zone adjustments.
SOAP includes the modifyItemsRequest method.
SOAP creates an event when a user is added to the proxy access list or modified on the proxy 
access list.
The SOAP recurrence rule string is parsed correctly.
SOAP ENVELOPE responses return field values correctly.
SOAP supports the ReplyWithText rule action.
The GWEventReader does not start unless SOAP is enabled.
Some document management activities can be performed using SOAP.
The ability to create and manage rules using SOAP has been improved.
SOAP correctly handles messages with blank subject lines.
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SOAP allows limited-license users to log in.
SOAP can read all attachments just as the client API can.
SOAP can handle attachments of over 2 GB.
If SOAP encounters an error reading a distribution list, it ignores the error and continues 
returning the data.
SOAP validates against the universal mailbox DRN (3) as well as the standard folder DRN (0) 
so that all attachments can be read and returned.
Fixed an abend on clustered servers.

14.10  GWCheck Fixes
When GWCheck encounters a message where an attachment is missing, it adds a dummy 
attachment so that the message can be processed normally during a user move.
The Reset Client Options action of GWCheck now retains user signatures. To reset user 
signatures as well, use the clearsig support option.
Running the Expire/Reduce action on Online mailboxes in ConsoleOne does not affect users’ 
Checklist folders in Caching mailboxes.
The new pabremove support option for GWCheck removes duplicate GroupWise user IDs that 
can occur in personal address books after a user has been moved.
The setting provided by the setmimeencoded support option is now synchronized from the 
Online mailbox to the Caching mailbox.
The storelowercase support option handles the situation where a file is missing from the 
catalog.
The storelowercase support option lower cases library and document archive pathnames.
Orphaned records are now cleaned up in archive databases as well as Caching/Remote 
databases.
The GWCheck audit report lists complete GroupWise user IDs even when they exceed 14 
characters.
Mailboxes can be updated for the time zone changes for daylight saving time in Australia. 
When you run GWCheck from ConsoleOne to set up a scheduled event, settings in the Support 
Options field on the Misc tab are executed as part of the scheduled event.
Linux GWCheck can be started using the ./gwcheck command when the gwcheck 
executable is in your current working directory.

14.11  Internet Agent Fixes
Viewing the Message Formatting property page of the Internet Agent object in ConsoleOne 
does not cause the Internet Agent to restart.
Internet e-mail address resolution to GroupWise users has been improved when two users have 
the same first and last names but have different preferred Internet e-mail addresses. The 
improvement affects all permutations of first name, last name, and first initial in the e-mail 
address.
The Internet Agent can perform an LDAP search on the Email Address attribute of a user.
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If the Internet Agent object does not have the Foreign ID field filled in on the GroupWise 
property page, the Internet Agent can still locate the recipient of the message.
Class of service exceptions work with Internet domain names that include dashes (-). 
The new /defaultnonmimecharset startup switch causes the Internet agent to use the character 
set specified in the message header instead of using the US_ASCII character set.
The Internet Agent uses the preferred Internet address, rather than constructing a 
user.po.domain address.
The Internet Agent constructs replies by external users using the preferred Internet address, 
rather than constructing a user.po.domain address.
When individual users are configured in ConsoleOne with external global signatures using 
Tools > GroupWise Utilities > Client Options > Send > Global Signature, the Internet Agent 
adds the signature when needed.
The Internet Agent converts iCal messages into GroupWise appointments even when it cannot 
log into the recipient’s post office.
With Flat Forwarding enabled, the Internet Agent no longer gets into a state of high utilization 
when processing a large number of deeply nested messages.
When Internet Addressing is not enabled, the Internet Agent still includes the Internet domain 
in the Reply To address.
If a user has both an internal and an external address, messages to external users are formatted 
so that replies are sent to the user’s preferred address. 
External messages do not have characters truncated at the end of lines.
The Internet Agent no longer truncates the MESSAGE-ID information in HTML-formatted 
messages. This problem was causing the GroupWise Windows client to crash on such 
messages.
Under a certain error condition, the Internet Agent no longer stops processing messages as a 
result of the error condition.
The Internet Agent POP server returns the full Message ID.
The Internet Agent uses the HTTP port to communicate with the SNMP daemon.
The GMT time zone is now correctly defined for the Internet Agent.
Daylight saving time processing of time zones in the southern hemisphere has been corrected.
For appointments from external e-mail systems, the Internet Agent uses the time zone 
information in the iCal message so that daylight saving time offsets are calculated correctly.
The Internet Agent includes the original time zone information when creating calendar items to 
facilitate future time zone adjustments.
The Internet Agent adheres to the RFC2231 Parameter Value Continuations section by 
accepting content type parameters in any order.
The Internet Agent adheres to RFC2045 by allowing x- parameters as part of the content type 
header.
The Internet Agent can properly process messages with attachments that were originally sent 
from Microsoft Exchange.
When the Linux Internet Agent is configured to start automatically on system startup and it is 
configured to start in a language other than English, it starts successfully in the language 
specified by the /language startup switch. 
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When the British pound sign (£) is included in a message from a GroupWise client, the Internet 
Agent encodes it into the MIME message correctly.
The Internet Agent can handle double-byte characters that occur in the X field of MIME 
encoding.
The Internet Agent now handles the Vietnamese currency symbol correctly.
The Internet Agent no longer converts ISO-2022-JP to Shift-JIS for HTML messages.
Fixed an Internet Agent memory leak.
Fixed some Internet Agent abends.

14.12  Monitor Fixes
None.

14.13  WebAccess Fixes
A cross-site scripting flaw in WebAccess that could allow users to be redirected to a malicious 
Web site has been eliminated. This vulnerability was discovered by Frederic Loudet and Brian 
Martin, BT INS (http://bt.ins.com) and was reported as CVE-2006-4220 and OSVDB 27531.
Name completion continues to work after you have attached a file to your message.
The WebAccess client provides display names for users rather than user IDs when you send, 
read, forward, and reply to messages.
Different users with the same display name can be selected from and address book and placed 
in the To field.
The same user cannot be added twice in the CC field.
Embedded links that contain ampersand (&) characters open properly in a browser window.
When you post a new task and specify a due date that is in the future, the specified due date is 
retained when you open the posted task.
If you forward a message from a shared folder that you are not the owner of, the recipient sees 
you as the sender of the message.
The time stamp on a message listed in the Mailbox window matches the time stamp in the Mail 
window when you open the message.
The WebAccess Agent includes the original time zone information when creating calendar 
items to facilitate future time zone adjustments.
In the Frequent Contacts address book, the user’s last name displays correctly in the Last Name 
field.
In a shared address book, the WebAccess client displays the correct user information from the 
personal address book.
A proxy user can modify and resend an item.
A proxy user with All User Access permissions can create and modify rules.
In the Safari browser on Macintosh, you can delete a single user in the To field drop-down list 
without other users disappearing. Other drop-down list issues on Safari were also fixed.
Extended characters in outgoing messages display correctly when the recipient’s e-mail system 
can handle the sender’s selected MIME encoding.
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Messages originating in other e-mail systems such as Exchange display using the correct 
character set.
HTML-formatted messages originating in Outlook display correctly when you reply to, 
forward, or print them in the WebAccess client.
The WebAccess Application timeout schedule is not disrupted by timeouts for other third-party 
programs.
When you use Reply or Reply to All to respond to messages where the sender or other recipients 
have extended characters in the users’ names, the characters are displayed correctly when the 
reply is received.
On a German keyboard, when you type “ü” in the To field, it displays correctly in all Web 
browsers.
Fixed some memory leaks in the WebAccess Agent.
Fixed some WebAccess Agent abends.
Fixed some Document Viewer Agent abends.

15  GroupWise Connector for Outlook
For installation instructions, known issues, and bug fixes relating to the GroupWise Connector for 
Microsoft Outlook, see the Support Pack 1 Readme for the GroupWise Connector for Microsoft on 
the GroupWise 7 Documentation Web site (http://www.novell.com/documentation/gw7).

16  GroupWise Mobile Server
For installation instructions, known issues, and bug fixes relating to GroupWise Mobile Server, 
Powered by Intellisync*, see the Support Pack 1 Readme for GroupWise Mobile Server on the 
GroupWise 7 Documentation Web site (http://www.novell.com/documentation/gw7).

17  Documentation
The following sources provide information about GroupWise 7 and have been updated for Support 
Pack 3:

Product documentation included with the software in the \docs\us directory: 
Quick Start (GroupWiseQuickStart.pdf)
Installation Guide (GroupWiseInstallationGuide.pdf)

Online product documentation: GroupWise 7 Documentation Web site (http://
www.novell.com/documentation/gw7) 

18  Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark; an asterisk (*) denotes a third-party 
trademark
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19  Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity of 
such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export 
controls and the trade laws of other countries. You agree to comply with all export control 
regulations and to obtain any required licenses or classification to export, re-export, or import 
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion 
lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not 
use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please 
refer to the Novell International Trade Services Web page (http://www.novell.com/info/exports/) for 
more information on exporting Novell software. Novell assumes no responsibility for your failure to 
obtain any necessary export approvals.

Copyright © 2008 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the 
publisher.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is 
described in this document. In particular, and without limitation, these intellectual property rights 
may include one or more of the U.S. patents listed on the Novell Legal Patents Web page (http://
www.novell.com/company/legal/patents/) and one or more additional patents or pending patent 
applications in the U.S. and in other countries.

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/
company/legal/trademarks/tmlist.html).

All third-party trademarks are the property of their respective owners.
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